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Trademarks

All brand and product names are trademarks or registered trademarks of their
respective companies.

Note
The information in this manual is subject to change without notice.



Regulations Information

Class B Regulations
USA

Federal Communications Commission Radio Frequency Interference Statement
NOTE:

This equipment has been tested and found to comply with the limits for a Class B digital
device pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

— Reorient or relocate the receiving antenna.
— Increase the separation between the equipment and receiver.

— Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Any changes or modifications not expressly approved by the manufacturer could void the
user’s authority to operate the equipment.

Please note:

The use of a non-shielded interface cable with this equipment is prohibited.

Canada

Canadian Department of Communications
Radio Interference Regulations Class B Compliance Notice

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites
applicables aux appareils numériques de la classe B prescrites dans le Reglement sur le
brouillage radioélectrique édicté par le ministére des Communications du Canada.



About the Modem

Caution

1. Never install telephone wiring during a lightning storm.

2. Never install telephone jacks in wet locations unless the jack is specifically designed
for wet locations.

3. Never touch uninsulated telephone wires or terminals unless the telephone line has
been disconnected at the network interface.

4.  Use caution when installing or modifying telephone lines.

5. Avoid using the telephone function (other than a wireless type) during an electrical
storm. There may be a remote risk of electric shock from lightning.

6. Do not use the telephone function to report a gas leak in the vicinity of the leak.

7. Do not use this product near water, for example near a bath tub, wash bowl, kitchen

sink or laundry tub, in a wet basement or near a swimming pool.

Caution (for USA Users)

To reduce the risk of fire, use only No.26 AWG or larger telecommunication line cord.
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Preface

This manual contains information that will help you operate your system.
It is divided into 7 chapters, an appendix and an index.

Chapter 1, Getting Started, takes you through the process of setting
up the system for use and identifying its external components.

Chapter 2, Computing Basics, tells you how to use the computer’s
typical components and features.

Chapter 3, Entertainment in AV Mode, tells you how to use the
system as a consumer home appliance such as a CD/MP3 player,
DVD player, TV set and FM radio.

Chapter 4, Entertainment in PC Mode, tells you how to use the
application programs in Windows XP to play a DVD/VCD, watch
TV and listen to FM radio.

Chapter 5, Expanding Your System, provides information on
installing and using peripheral devices.

Chapter 6, Drivers and Software CDs, describes how to use the CDs
supplied with your system.

Chapter 7, Caring and Troubleshooting, gives you tips in care and
maintenance as well as solutions to common problems you may
encounter when using the system.

Appendix contains information for system specifications and the
BIOS Setup program.




Notational Conventions

Throughout this manual, the following conventions are used to
distinguish elements of text.

| NOTE: identifies additional information that requires special attention.

CAUTION: identifies important information which, if not followed, may result in loss of
data or damage to the system.

Keyboard keys and remote control buttons are shown in a bold typeset.
For example:

Press Enter to complete.

When keys are joined by a plus sign (+), press the first key, and, while
keeping the first key down, press the remaining keys, finally release all
the keys. When necessary, keys are also shown in graphics.

A title, command, setup item or button that you can see on the screen is
shown in boldface. If several menu commands must be selected in
sequence, they will be separated with a greater-than sign (>). For
example:

Select Start > Settings > Control Panel > Power Options, select
Home/Office Desk and then click the OK button.

As your system can operate either in 4V mode or PC mode, the mode
names are shown in italic to call your attention to the specific operation in
a specific mode.

vi



CHAPTER 1

Getting Started

Congratulations on purchasing this “AV PC” — a next-generation
multimedia computer system that incorporates a desktop computer, a
large LCD (Liquid Crystal Display) and a stereo speaker set into one
compact package design. A wireless keyboard and mouse are also
included as standard accessories.

In addition to typical computer capabilities, your system offers complete
home entertainment features such as CD/MP3 player, DVD player, FM
radio' and TV' with a remote control. Whether you are working or
relaxing, the system is here to satisfy your needs.

This chapter first introduces the external components of your system and
then tells you step by step how to get your system up and running.
Finally, it navigates you to the information you may need after your
system is ready for use.

NOTE: Depending on the model you purchased, the appearances of your computer
and its accessories may not be exactly the same as shown in this manual.

! For select models only



Unpacking

| NOTE: Depending on the model you purchased, the appearance of your computer and
its accessories may not be exactly the same as those shown in this guide.

After unpacking the shipping carton, you should find the following items.

— L1

Computer
©o @
- s
& ) as @
&
Ferrite cores Wireless keyboard Wireless mouse

= e @mEmm

FM antenna * AV/S video cable * Remote control
AC power cord Modem cable
Floppy disk drive * Document and CD

* Select models only

Inspect all the items. If any item is damaged or missing, notify your
dealer immediately.

Keep the shipping carton and packing materials in case you need to ship
or store the system in the future.
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Taking a Look at the System

This section identifies the external components of your system and
briefly describes the function of each component.

Front Components

Getting Started
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Ref Component

Power Button

Description See Also

Turns the computer power ON and OFF. P.1-13

Brightness Control

Adjusts the brightness of the LCD display. P. 1-15

0o e

LCD Screen Displays the output of the system. P.2-17
Indicators Show the status of the keyboard/mouse. P.2-4
Num Lock
Caps Lock
Scroll Lock
\4

Wireless Transmission In-Use

Remote Sensor

®

Receives signal input from the remote
control.

@ Stereo Speaker Set

Sends out sound and voice from the system.  P. 2-17

@ System Indicators

Show the status of the system.

0

Power indicator: P.1-13
— Glows green when the system is in use.
— Glows amber when the system is in
Windows Stand By mode.
— Glows red when the system is in a
“soft-off” state. “Soft-off” is a state that
standby +5 V power is supplied to the
system.

Hard disk drive in-use indicator

@ |ao

CD/DVD drive in-use indicator
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Right-Side Components

Ref Component Description See Also
© CD/DVD Drive Accepts a compact disc for installing or P.2-14
loading software, accessing data, and playing
music/video.
@® FM Antenna Connects to a FM antenna for listening to FM  P. 1-11
Connector radio.

(select models only)

© TV RF Connector  Connects to a TV RF cable for watching cable ~ P. 1-11
(select models only) TV.

@ Video Input Connects an external video device such as a P.5-6
Connector VCR, camcorder or video game console for
(select models only) video input.
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Left-Side Components

o BE

Ref Component Description See Also
@ PC CardSlot Accepts a PC Card for additional functions. P.5-8
@ Card Reader Accepts a SmartMedia (SM), MultiMediaCard P. 5-10

(select models only) (MMC), Secure Digital (SD) or Memory Stick
(MS) card for removable storage media.

© USB Ports Each of the two ports connects a USB device, P.5-2
such as a floppy disk drive, printer, digital
camera, joystick and more.

@ Power Connector  Connects the AC power cord. P. 1-12
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Rear Components

SPDIF

.9,
o

00~
[ JO
00:

Ref Component Description See Also

@ Microphone Connects an external microphone. P.5-4
Connector

@ Audio Input Connects a Hi-Fi set, radio set, synthesizer, P.5-4
Connector walkman, etc for audio input.

© Audio Output Connects a set of headphones, external P.5-4
Connector speakers with amplifier, or an audio

recording device for audio output.

S/PDIF Output Connects a S/PDIF device such as a digital P.5-5
Connector speaker set for digital audio output.

Mini IEEE 1394 Port Connects a 1394 device such as a scanner, P5-3
printer, DVCAM, VCR and more.

IEEE 1394 Port

O|@|® ©

RJ-11Connector Connects the modem cable. P 2-18
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©® RJ-45 Connector Connects the network cable. P.2-19

© USB Ports Each of the two ports connects a USB P.5-2
device, such as a floppy disk drive, printer,
digital camera, joystick and more.

Keyboard and Mouse

Ref  Component Description See Also

@ Wireless Serves as the data input device of the system. P.2-4
Keyboard

@ Multimedia Easy Each of the six buttons (FM, TV/IVCR, DVDVCD,  P. 1-13
Start Button CD/MP3, PC, and Stand By) provides a quick
(MESB) way to activate a home entertainment feature.

© Wireless Mouse  Serves as the pointing device of the system.
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Setting up the System for Use

Selecting a Site

Select a site that has:

a sturdy and level surface

space for ventilation

a grounded three-pronged electrical outlet nearby

available modem or network cable connection (for connecting to
Internet)

available TV RF cable connection (for watching TV)

CAUTION: Slots or openings on the system are for ventilation. Do not block or cover
the ventilation openings.

Installing the Batteries

CAUTION:

o When replacing the batteries, use two batteries of the same type and manufacturer.
Replace the two batteries at the same time. Do not mix the use of old and new
batteries.

o When not using the battery for a long period (more than one month), remove the
batteries to prevent damage from battery corrosion.

¢ In case the battery leaks, clean the liquid and install new batteries.

o Check the regulations of your local government for proper battery disposal.

Installing Batteries for the Wireless Keyboard

1.
2.
3.

Prepare two “AAA” batteries of the same type and manufacturer.
Remove the keyboard battery door at the back of the keyboard.

Install two “AAA” batteries into the battery compartment. A diagram
in the interior of the battery compartment shows the orientation of the
batteries.

Replace the battery door.
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Installing Batteries for the Wireless Mouse

1. Prepare two “AAA” batteries of the same type and manufacturer.
2. Remove the mouse battery door.

3. Install two “AAA” batteries into the battery compartment. A
diagram in the interior of the battery compartment shows the
orientation of the batteries.

4. Replace the battery door.

0 iy

(i Eome 0
2

CHI CH2,
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Installing Batteries for the Remote Control

1. Prepare two “AAA” batteries of the
same type and manufacturer.

2. Remove the battery door by sliding it
away from the remote control.

3. [Install two “AAA” batteries into the
battery compartment. A diagram in the E
interior of the battery compartment
shows + and — ends of the batteries.

4. Slide the battery door back into place
and make sure it clicks into position.

!

Making Connections

Entertainment

If your system has the TV card installed, you can connect the TV RF
cable to watch cable TV and connect the FM antenna to listen to FM
radio.

| NOTE: You need to have an account with a cable TV provider to watch cable TV.
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FM antenna

SN

TV RF cable

Power

Plug the female end of the AC power cord to the power connector on the
left side of the system and plug the male end to an electrical outlet.

iy

CAUTION:

o When you disconnect the AC power cord, disconnect from the electrical outlet first
and then from the system. A reverse procedure may damage the system.

o When unplugging the connector, always hold the plug head. Never pull on the cord.

1-12

Getting Started



Starting to Use the System

After making all the connections, you can start to use the system. This
section helps you get started.

AV Mode and PC Mode

A unique feature of your system is that it can offer home entertainment
elements in either AV mode or PC mode. The entertainment elements
include CD/MP3 player, DVD player, TV and FM radio.

o AV mode
In AV mode, your system acts as a consumer home appliance with a
remote control. You can see on the screen a control panel resembling
that of a consumer home appliance.

e PCmode
In PC mode, your system acts as a personal computer under Windows
XP environment. You use multimedia application programs to access
entertainment elements.

NOTE: The availability of entertainment elements depends on the model of your
purchase.

Powering On
Powering On to AV Mode

To activate a specific consumer home appliance, simply press a
Multimedia Easy Start button on the keyboard or the remote control.

The Power indicator will turn green and you will see a corresponding
control panel or video on the screen. You are now in AV mode. (See
Chapter 3 for details on using the entertainment elements in AV mode.)

Powering On to PC Mode

Powering on to PC mode means starting Windows XP. You can press the
power button on the top of the LCD or the PC button on the keyboard or
remote control to start up.
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The Power indicator will turn green and Windows XP will start up. (See
Chapter 4 for details on using the entertainment elements in PC mode.)

Powering Off

Ways of powering off the system are different depending on the current
mode:

e Ifin PC mode (Windows XP):
Click Start at the lower left corner of Windows XP tool bar and click
Turn Off Computer. From the popup dialog box, click Turn Off.
You can also press the power button to turn off. (See “Controlling the
Computer Power” in Chapter 2 for more information.)

o Ifin AV mode:
Press the Stand By button or the power button.

When you power off the system, the Power indicator will turn from green
to red, meaning that the system is in a soft-off state.

Adjusting the Display

You can tilt the display for viewing
clarity. Holding the two corners of
the LCD’s upper edge, you can tilt it
backward for approximately 25
degrees.
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To adjust the brightness of the LCD,
use the brightness control located on
the top of the LCD.

Putting Away the Keyboard

You can put away the keyboard when you do not need it, for example,
when you are simply listening to music. A slot along the upper edge of the
keyboard allows you to stand it on the system base.
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Where to Go from Here

Now that your system is ready for use, you may want to do any of the

following:

For this purpose...

Do this...

To know the basics of using your system  See Chapter 2.
as a personal computer...

To know how to use the home See Chapter 3.
entertainment features in AV mode. ..

To know how to use the home See Chapter 4.

entertainment features in PC mode. ..

To know more about Windows...

Read the Windows on-line help.

To install the drivers and programs if your
dealer has not already done so...

See Chapter 6.

To set a power-on password...

See “Security Menu” in the
Appendix.
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Computing Basics

CHAPTER 2

This chapter provides information on using your system as a personal
computer. If you are new to computers, reading this chapter will help you

learn the computer operating basics.

Described in this chapter are the operating basics of these components:

Keyboard

Mouse

Floppy disk drive
Hard disk drive
CD/DVD drive

And these features:

Power saving features
Video and audio features

Communication features



Controlling the Computer Power

Starting the Computer

NOTE:

o Starting (or “booting”) the computer is the process of loading the operating system
(OS) from a storage device such as a hard disk.

o An operating system is the platform for all your software application programs to
run on. The most widely used operating system today is Microsoft Windows. Your
computer is designed to use Windows XP as the operating system.

To start the computer, press the power button on the top of the LCD. You
can also press the PC button on the keyboard or remote control.

The Power indicator will turn green and Windows XP will start up.

Turning Off the Computer

To turn off the computer, click Start > Turn Off Computer > Turn Off.
You can also press the power button to turn off the computer.

NOTE: If the system is locked up because of hardware or software problems, press the
power button for 4 or more seconds to turn off the computer.

When you turn off the computer, the Power indicator will turn from green
to red, meaning that the system is in a soft-off state.

Power Options

Windows XP allows your system to enter Stand By and Hibernation
mode. You can configure power settings by clicking Control Panel >
Power Options.

Stand By

Stand By in Windows XP is the computer’s being in a power saving
status.

Computing Basics



You can set up a timer so that the computer will automatically enter Stand
By mode when it has been idle for the specified time period. You can also
manually initiate Stand By using one of the following methods:

e Press the Stand By button on the keyboard or remote control.
e C(Click Start > Turn Off Computer > Stand By.

® You can also use the power button if you have assigned the function
to the power button in Power Options.

When Windows XP Stand By is initiated, the screen will blank out and
the system enters a power saving status. The Power indicator will light
amber.

To end Stand By mode and resume operation, press the power button, PC
button or Stand By button.

Hibernation

CAUTION: To use the hibernation feature, hibernation must be enabled in the
Hibernate tab of Power Options.

Hibernation is a very useful feature. People frequently open many
applications when they use computers. It takes some time to get all these
applications open and running, and normally they all have to be closed
before the system can be turned off.

When you use the hibernation feature, you do not have to close the
applications. The computer stores the state of your computer to a file on
the hard disk and then shuts down. When you next turn on your computer,
you return to exactly where you left off.

You can manually initiate Hibernation using one of the following
methods:

e C(Click Start > Turn Off Computer. When the “Turn off the
computer’ dialog box appears, press the Shift key to change Stand By
to Hibernation and then select Hibernation.

e You can also use the power button if you have assigned the function
to the power button in Power Options.
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Using the Keyboard

A keyboard is an input device. Your system comes with a wireless
keyboard. A built-in receiver inside your system picks up the signals from
this keyboard when it is within a valid distance.

The keys on your keyboard can be divided into four major areas:
typewriter keys, cursor-control keys, numeric keys and function keys.

Typewriter Keys

Y T =) i
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Typewriter keys are similar to the keys on a typewriter. Several keys are
added, such as the Ctrl, Alt, Esc and lock keys, for special purposes. When
the lock keys are pressed, their corresponding indicators light up.

Key

Ctrl

Description

The Control key is normally used in combination with other keys for
program-specific functions.

Alt

The Alternate key is normally used in combination with other keys
for program-specific functions.

The Escape key is usually used for stopping a process. Examples are
exiting a program and canceling a command. The function depends
on the program you are using.

4{>Shift

The Shift key is used with alphabet letter keys to produce uppercase
letters when typing. It is also used in combination with other keys
for program-specific functions.

W

The Backspace key moves the cursor left one space and deletes the
character in that space.

2-4
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Num LK The Number Lock key toggles the Num Lock on and off. The Num
Scrtk Lock indicator lights up to indicate that numeric keys are activated.

Pressing Fn and this key toggles Scroll Lock on and off. The Scroll
Lock indicator lights up to indicate that Scroll Lock is activated,
meaning that the screen will move one line up or down when you
press T or { arrow key. Scroll Lock does not work for all programs.

-I The C.aps: Lock lfey toggles.the. Caps Lock on and off. The Caps

Lock indicator lights up to indicate that Caps Lock is activated,
meaning that the letter keys will generate uppercase letters.

Fause The Pause key temporarily stops screen scrolling. Pause does not
work for all programs.
The Print Screen key prints the displayed screen. Print screen does
not work for all programs.
a The ¥ Windows Logo key opens the Start menu. It performs
software-specific functions when used in combination with other
keys.

The =% Application key usually has the same effect as a right mouse
click.

Cursor-Control Keys

S N mess=
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NOTE: The word “cursor” refers to the indicator on the screen that lets you know
exactly where on your screen anything you type will appear. It can take the form of a
vertical or horizontal line, a block, or one of many other shapes.

Cursor-control keys are generally used for editing purposes. They are:
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Description

Moves the cursor left one space.

Moves the cursor right one space.

Moves the cursor up one line.

Moves the cursor down one line.

Palp Moves the page up.

Moves the page down.

Moves the cursor to the beginning of the line or document.

Moves the cursor to the end of the line or document.

(0EEHEELE

The Insert key switches typing between insert and overtype modes.
Insert mode means any character typed will be inserted to the current
cursor position; overtype mode means any character typed will
overwrite the text in the current cursor position.

E

The Delete key deletes the character to the right of the cursor and moves
the following text left one space.

Numeric Keypad

H@%ﬁ%@@%@%ﬁl‘h@' ==
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Numeric keys facilitate entering of numbers and calculations. When Num
Lock is on, the numeric keys are activated, meaning you can use these
keys to enter numerals.

DCE

IR e.
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NOTE:

o When Num Lock is off, the keys on the numeric keypad become cursor-control keys.

o To type the Euro sign ( € ), hold down either of the Alt keys and type 0128 on the
numeric keypad of your keyboard.

Function Keys
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On the top row of the keys are the function keys: F1 to F12. Function keys
are multi-purpose keys that perform functions defined by individual
programs.

E:

The Fn key, at the lower left corner of the keyboard, is used with another
key to perform the alternative function of a key. To perform a desired
function, first press and hold Fn, then press the other key.

Hot Keys

Hot keys refer to a combination of keys that can be pressed any time to
activate special functions of the system.

The hot keys of your system are described below.

Keys Description

en LT (5 Decreases the volume.

—
N—

F2
En + Increases the volume.
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Using the Mouse

A mouse is a pointing device that allows you to communicate with the
computer by controlling the location of the pointer on the screen and
making selection with the buttons.

Depending on your model, a wireless optical mouse may be supplied with
your system. A built-in receiver inside your system picks up the signals
from this mouse when it is within a valid distance.

To use the mouse, slide it on a clean, flat surface (such as your desktop)
and the pointer on the screen moves accordingly.

An optical mouse uses optical sensor technology. When compared with a
traditional trackball mouse, it is more precise and durable.

NOTE: An optical mouse works on most surfaces without a mouse pad. However, you
should avoid the following surfaces: surfaces without texture (such as glass), reflective
surfaces (such as a mirror) and surfaces with irregular texture (such as color pictures or
magazines).

Here are some common terms that you should know when using the
mouse:

2-8
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Point Slide the mouse until the cursor points to your selection
on the screen.

Click Press and release the mouse button (usually the left
button).
Double-click Press and release the mouse button (usually the left

button) twice in quick succession.

Drag and drop Press and hold the mouse button (usually the left button),
then move the mouse until you reach your destination
(drag). Finally, release the button (drop) when you finish
dragging your selection to the destination. The object
will drop into the new location.

Scroll To scroll is to move up and down in the working area on
the screen (available only if your mouse has the scroll
wheel).

Place your finger on the wheel and rotate it upward or
downward to move vertically.

This function may not work for all applications.

Configuring the Mouse

You may want to configure the mouse to suit your needs. For example, if
you are a left-handed user, you can swap the two buttons so that you can
use the right button as the left button and vise versa. You can also change
the size of the on-screen pointer, the speed of the pointer, and so on.

To configure the mouse, click Control Panel > Mouse.
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Using the Floppy Disk Drive

CAUTION:
o Do not use the floppy disk drive in an upside-down position.
o Do not put objects on top of the floppy disk drive.

Depending on your model, a USB floppy disk drive may be supplied with
your system. The floppy disk drive is referred to as drive A.

A floppy disk drive allows you to install new programs into your
computer, or to store information on a removable floppy disk so that you
can transfer information from one computer to another.

[

Write Protect Tab High Density Notch
Ll E|

The drive is a high-density 3.5-inch one, which can read and write to
either double-density (2DD) 720-KB floppy disks or high-density (2HD)
1.44-MB floppy disks. A floppy disk have an arrow imprinted on the
front upper left corner, and a sliding write-protect tab on the bottom left
corner, as illustrated above. When opened, the write-protect tab prevents
data from being written to or erased from the floppy disk.

Connecting the Floppy Disk Drive

To connect the floppy disk drive, plug the floppy disk drive cable into any
of the USB ports of the system. You do not have to turn off the computer
before connecting. Once connected, the drive is ready for use.
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Inserting and Ejecting Floppy Disks

CAUTION:

o Afloppy disk must be formatted before you can use it.

o Never turn off or reset the computer while the floppy disk drive in-use indicator is on.

o Always store your floppy disks in a safe, clean container, to protect them from the
environment and magnetic fields.

To insert a floppy disk, hold it with the arrow facing up and towards the
drive. Slide the disk into the drive until it clicks into place.
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In-Use Indicator

Eject Button

To eject a floppy disk, first ensure that the floppy disk drive in-use
indicator is off, and then press the eject button on the drive. When the
floppy disk pops out of the drive, remove the disk and store it properly.
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Using the Hard Disk Drive

Your system comes with a hard disk drive as drive C.

A hard disk drive is a storage device with non-removable, rotating,
magnetic storage platters inside it. It is where your operating system and
application software programs are stored.

Your hard disk drive is a 3.5-inch IDE (Integrated Drive Electronics) hard
disk drive. This type of drive embodies the latest technology in fast,
reliable mass storage by integrating all the control circuitry necessary for
operation directly onto the drive itself. This allows the drive
manufacturer to carefully optimize drive performance.

CAUTION:

o Make regular backups of your data files from your hard disk drive to floppy disks or
other storage media. This can prevent losing data because of a computer virus or
an accident.

o Never try to remove or install the hard disk drive while the system is powered on.
Doing so can result in loss of data, and can damage the system and the hard disk
drive’s sensitive circuitry.

o Never turn off or reset the computer while the hard disk drive in-use indicator is on.

Computing Basics 2-13



Using the CD/DVD Drive

Your system comes with a CD/DVD drive, usually configured as drive D.

The drive uses removable 5.25-inch silver discs. It is an ideal medium to
use for distributing multimedia because of the huge amount of data that a
disc can store.

Depending on the model, your drive is one of the following:

e CD-ROM drive can read CD-ROMs, audio CDs, video CDs, CD-R,
and CD-RW discs.

e CD-RW drive can not only read the above discs but also write to
CD-R and CD-RW discs.

o DVD-ROM drive can read DVD (Digital Versatile Disc) in addition
to the above discs.

e Combo drive can work both as a DVD-ROM drive and CD-RW
drive.

CAUTION:

o When inserting a CD, do not use force.

o Make sure that the CD is correctly inserted into the tray, and then close the tray.

o Do not leave the CD tray open. Also, avoid touching the lens in the tray with your
hand. If the lens becomes dirty, the CD-ROM may malfunction.

o Do not wipe the lens using materials with rough surface (such as paper towel).
Instead, use a cotton swab to gently wipe the lens.

FDA regulations require the following statement for all laser-based devices:
“Caution, Use of controls or adjustments or performance of procedures other than
those specified herein may result in hazardous radiation exposure.”

NOTE: The drive is classified as a Class 1 laser product. This label is located on the
drive.

CLASS 1 LASER PRODUCT
LASER KLASSE 1

2-14 Computing Basics



NOTE: For DVD/Combo drive only.

This product incorporates copyright protection technology that is protected by method
claims of certain U.S. patents and other intellectual property rights owned by
Macrovision Corporation and other rights owners. Use of this copyright protection
technology must be authorized by Macrovision Corporation, and is intended for home
and other limited viewing uses only unless otherwise authorized by Macrovision
Corporation. Reverse engineering or disassembly is prohibited.

Inserting and Removing a CD

| NOTE: The following procedure applies to inserting or removing a DVD as well.

Follow this procedure to insert or remove a CD:

1.  When the system power is on, press the eject button on the drive and
the CD tray will slide out partially. Gently pull it until it is fully
extended.

2. Toinsert a CD, place the CD in the tray with its label facing the front
of the system. Slightly press the center of the CD until it clicks into
place.

CAUTION: Never try to use a cracked CD. The speedy rotation inside the drive can
shatter the cracked CD and therefore damage the drive and even cause bodily injury.

— Eject Button

To remove a CD, slightly press the center of the CD and, holding the
CD by its outer edge, lift it away from the tray.

3. Gently push the tray back into the drive.
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NOTE: In the unlikely event that you are unable to release the CD tray by pressing the
eject button, you can manually release the CD. (See “CD/DVD Drive Problems” in
Chapter 7.)
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Using the Video and Audio Features

NOTE: The video and audio drivers supplied with your system must be installed to
ensure normal operations of the video and audio features.

Combining the LCD display and speaker set into one unit, your system is
complete with video and audio capabilities.

You screen is a 17-inch TFT (Thin-Film Transistor) color LCD display
with 1024x768 XGA (Extended Graphics Array) resolution. The surface
is protected by reinforced glass. The display has been set to a default
resolution and number of colors before shipment. You can view and
change display settings by clicking Control Panel > Display.

Your speaker set is located on the right and left side of the LCD display.
The volume is adjustable through the hot keys (Fn+F3 and Fn+F4) or
Windows XP Control Panel (by clicking Control Panel > Sounds and
Audio Devices > Volume tab > Advanced button in Device volume).

NOTE:

e The volume setting of Windows XP Control Panel is the master control. It
determines the valid volume range of a multimedia program.

o Make sure that the Wave item of Windows XP Control Panel is enabled if you are
using the internal speaker set.

In addition to the built-in speaker set, your system provides three audio
connectors for audio input and output. (See “Connecting Audio Devices”
in Chapter 5 for more information.)

If your model has the TV card installed, you can also use these features:
e Watch TV on the LCD (See Chapter 3 and 4 for more information.)
e Listen to FM radio (See Chapter 3 and 4 for more information.)

e Receive video input from external video devices (See “Connecting a
Video Device” in Chapter 5 for more information.)
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Using the Communication Features
Using the Modem

NOTE:

e The modem driver supplied with your system must be installed to ensure normal
operations of the modem features.

e You need to establish an account with an ISP (Internet Service Provider).

The internal 56 K fax/data modem allows you to use the ordinary
telephone line to communicate with others by fax, email or connect to
Internet.

Plug the connector end with the core to the RJ-11 connector on the system
and the other end to the telephone outlet.

I >

NOTE:

o When using communication software, you may have to disable power saving
settings. Do not enter Standby when using communication software.
Set the COM port of the modem to COM3.
Set parameters such as modem speed (baud rate) and line type (pulse dialing or
tone dialing).
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Using the LAN

NOTE: The LAN driver supplied with your system must be installed to ensure normal
operations of the LAN features.

The internal 10/100Base-T LAN (Local Area Network) module allows
you to connect to a network. It supports data transfer rate up to 100 Mbps.

1. Before connecting, you must attach the ferrite core to the network
cable. A ferrite core is for minimizing electromagnetic interference.
a. Open the ferrite core.
b. Wind the network cable around the core for one circle, leaving

2 ~ 3 cm between the core and the connector end.

c. Close the ferrite core.

2. Plug the connector end with the core to the RJ-45 connector on the
system and the other end to the network hub.

aaNAAAANANARNNANANANARANARNNNAAARANARANND
nnnnnnnnnnnnn HAAAAARR A ArARARARARARARAAA
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CHAPTER 3

Entertainment in AV Mode

Your system can function as a consumer home appliance. With a remote
control, you simply use it as a CD player, DVD player, FM radio or TV
set.

This chapter tells you how to use your system as the following
appliances:

e CD/MP3 player

e DVD player (select models only)
e TV set (select models only)

e FM radio (select models only)



CD/MP3 Player
Starting the CD/MP3 Player

Press the CDIMP3 button to use your system as a consumer CD/MP3
player. The CD/MP3 control panel appears on the screen.

NOTE: If you press the CD/MP3 button when the system is in a soft-off state, you will
be in AV mode. If you press the button while in Windows, you will be in PC mode.

MP3

Stop or Pause) |— Mute ™ indicator

Current status (Play, Repeat mode
— CD indicator —‘

2003 0505

\—Volume

Total track/file number

Elapsed time of the
current track/file

Current track/file length Current track/file number

e  When there is already an audio CD in the drive, the system will start
playing the CD.

o When there is no CD in the drive, the system will play the MP3 files,
if any, in the c:\mp3 folder. To play an audio CD, insert the CD and
press the CD/MP3 button.

NOTE:

o You can download MP3 files from the Internet and save the files in the c:\mp3
folder.

e The CD/MP3 player can also play the MP3 files on a CD.
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Controlling the CD/MP3 Player

Use the remote control to control the CD/MP3 player.

To Press Button Name
Play back/Pause the playback. @ Play/Pause
Stop the playback. @ Stop
Fast backward or forward. E "« [E” ''''' - Fast Backward/
Press the button repeatedly until you reach Fast Forward

your destination.

Pre.Chapter Next Chapter

Play the previous or next track or file. Previous Chapter/

Next Chapter
Select the repeat mode: Lé Repeat
{81 By sequence
1‘3 Repeat the current track
&l By reversed sequence
f71 By random sequence e Shuffle
Toggle mute on or off. A Mute

Decrease or increase the volume. Volume Down/
Volume Up

Stopping the CD/MP3 Player

| NOTE: During the playback in AV mode, you cannot eject a CD.

Press the Stop button to stop the playback.

When you have finished using the player, you can switch directly to
another mode or element. If you want to directly turn the system off, press
the Stand By button or power button.
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DVD Player

If your system comes with a DVD or Combo drive, you can use the DVD
player.

Starting the DVD Player

Press the DVDIVCD button to use your system as a consumer DVD player.

NOTE: If you press the DVD/VCD button when the system is in a soft-off state, you will
be in AV mode. If you press the button while in Windows, you will be in PC mode.

e Ifyou have inserted a DVD before starting the DVD player, the
system will start playing the DVD.

e [fyou have not inserted a DVD, insert it now and press the Play
button to start playing the DVD.

NOTE: Some DVDs have regional settings. When you play a disc from a different region,
you will be unable to play the disc in AV mode unless you change the region setting in PC
mode. (See “WinDVD Setup” in Chapter 4 for information on region settings.)

Controlling the DVD Player

Use the remote control to control the DVD player.

To Press Button Name
Execute your selection. Enter
Play back/Pause the playback. @ Play/Pause
Stop the playback. @ Stop
Fast backward or fast forward. EFEMM E] == Fast Backward/
Press the button once to backward or Fast Forward

forward in 2x speed. If you press the button
repeatedly, the speed will be raised to 4x, 8x
and 20x.

Press the Play button to play back when you
have reached your destination.
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Play the previous or next chapter.

o

hapter Next Chapter

®
®

Previous Chapter/
Next Chapter

Select a chapter number to play the selected
chapter.

QOO
OeE

Numeric Keys

Oleeee

Display the DVD menu. Menu
Move up, down, right and left within the Up/Down/Right/
DVD menu. Left Arrow

Open or close the caption. Caption provides
a textual equivalent of a motion picture
soundtrack for deaf and hard of hearing
audiences.*

Close Caption

Select a subtitle.* Subtitle
Select an audio mode.* Audio
Select a viewing angle.* A<> Angle
Toggle mute on or off. <M> Mute

Decrease or increase the volume.

24

Volume Down/
Volume Up

Table Note:

* depends on the current DVD in use. Not all DVDs support the options.

Stopping the DVD Player

Press the Stop button to stop the playback.

When you have finished using the player, you can switch directly to
another mode or element. If you want to directly turn the system off, press

the Stand By button or power button.
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TV Set

If your model has the TV card installed, you can use your system to watch
TV or play back video from an external source.

NOTE: To watch cable TV, you need to have an account with a cable TV provider and
connect the cable to your system.

Starting the TV

Press the TVIVCR button to use your system as a TV set. Live TV broadcast
appears on the screen.

NOTE: If you press the TVIVCR button when the system is in a soft-off state, you will be
in AV mode. If you press the button while in Windows, you will be in PC mode.

Scanning TV Channels

You must scan all available channels before you can watch TV.

When you use TV in AV mode for the very first time, the channels will be
automatically scanned. After that, you can use the remote control to
switch to a channel for watching.

Controlling the TV

Use the remote control to control the TV set.

To Button Name

Switch to one of the three video input sources: TVIVCR

TV, S-video and AV.

Switch to a channel by selecting a number. * Numeric Keys
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Channel Up/
Channel Down

Go to the previous or next channel.*

¢

Display/Repeat

Display the current channel number. Display

O

JumpiShuffle

Switch to the channel last accessed. Jump

O

C.C/Mem

Open or close the caption if supported by the Close Caption
TV broadcast. Caption provides a textual
equivalent of a TV show soundtrack for deaf

and hard of hearing audiences.

O

Switch the audio mode. MTS
In NTSC systems, the available options are
SAP, Stereo and Mono.

(select models only)

5
< ) =1
»

Toggle mute on or off. Mute

Decrease or increase the volume. Volume Down/
Volume Up

Table Note:
*In AV mode, all scanned channels are accessible. No channels can be canceled.

Stopping the TV

When you have finished using the TV, you can switch directly to another
mode or element. If you want to directly turn the system off, press the
Stand By button or power button.
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FM Radio

If your model has the TV card installed, you can use your system to listen
to FM radio.

NOTE: You must connect the FM antenna before you can listen to FM radio. If the
signal quality is not good, try relocating the antenna.

Starting the Radio

Press the FM button to use your system as a consumer FM radio. The radio
control panel appears on the screen.

NOTE: If you press the button when the system is in a soft-off state, you will be in AV
mode. If you press the button while in Windows, you will be in PC mode.

Scanning is completed. Current frequency
Scanning is in progress. Mute
Signal strength —|

Volume Volume
Favorite channels

Controlling the Radio

Use the remote control to control the radio.

To Press Button Name

Angle/Scan

Initiate the scanning mode to search for FM Scan

channels available in your area.
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If signal quality is not good, you can fine tune @ @ Fine Tune Up/
the channel by searching up or down by 0.05 Fine Tune Down
MHz at a time.

Stop the scanning mode. Exit

channel. Channel Down

Search for the previous or next available A Channel Up/

Select a favorite channel to listen to if you Numeric Keys

OO
have created your favorite channels. (See @ @ @
QJOXO,

“Saving Favorite FM Channels” later in this

section.)

Switch to the channel last accessed. J"mbw"e Jump
Save the current channel as a favorite channel. N Memory
(See a later subsection for details.)

Toggle mute on or off. <M> Mute

Decrease or increase the volume. Volume Down/
Volume Up

Stopping the Radio

When you have finished using the radio, you can switch directly to
another mode or element. If you want to directly turn the system off, press
the Stand By button or power button.

Saving Favorite FM Channels

You can create your own favorite channel list and then easily access the
channels by pressing a numeric key on the remote control. Up to 10
favorite channels are allowed.

NOTE: Favorite channels in AV mode and PC mode work independently, so you should
save the favorite channels separately.
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There are two ways to save the favorite channels.

Saving Favorite Channels by Scanning

1.
2.

4.

Press the Scan button to initiate the scanning mode.

Upon the first channel scanned, an available number on the control
panel will light up (number 1 lights up for first time use). If you wish
to use another number, press the Mem button as many times as it
requires to reach the desired number. If you do not want this channel
as a favorite channel, press the Scan button as many times as it
requires to reach the desired channel.

When you have finished assigning numbers to channels, press the
Enter button to save the settings.

To end the scanning mode, press the Exit button.

Saving Favorite Channels by Searching

1.
2.

Press the Ch+ or Ch— button to search for the channel you wish to save.

To save the selected channel, press the Mem button and an available
number on the control panel will light up (number 1 lights up for first
time use). If you wish to use another number, press the Mem button as
many times as it requires to reach the desired number.

Press the Enter button to save the setting.

To continue with the other favorite channels, repeat steps 1 to 3.
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CHAPTER 4

Entertainment in PC Mode

When you are in Windows XP environment, you can use multimedia
application programs to fully enjoy entertainment features. In addition to
the standard Microsoft Windows Media Player, your system provides the
following multimedia programs:

e WinDVD for playing DVD/VCD (select models only)
e WinFast PVR for watching TV (select models only)
e WinFast FM for listening to FM radio (select models only)

This chapter tells you how to use these programs.



WinDVD: Playing DVD/VCD

In PC mode, you can use the WinDVD program to play a DVD or VCD if
your model comes with a DVD or Combo drive.

WinDVD is a simple-to-use software DVD player combining all the
features of a standard consumer DVD player with some very advanced
functionality only possible on a software DVD player. For example, you
can use time-stretching, zoom and pan, create bookmarks and capture
screen images. Imagine this: you do not have quite enough time, so you
speed up the playback of the movie using the “time-stretching” feature.
As a result, you still view the entire movie without sacrificing the
smoothness of the sound.

This section tells you what WinDVD has to offer and provides basic
operating instructions. For advanced operations, refer to the WinDVD
online help where you can find the latest and complete information.

Playing a DVD/VCD

You can use WinDVD to play a DVD, VCD or an audio CD.

1. You can start WinDVD by either of the following ways:
e C(lick Start > Programs > InterVideo WinDVD > InterVideo
[0 WinDVD to start the program.
e Press the DVD button on the remote control to start the program.

2. a.Ifthe disc (DVD, VCD or CD) has been inserted before you start
the program, the playback will start.
b. If the disc has not been inserted, insert it now and click <= Play
button at the left side of the Control Panel, or the Play button on the
remote control.

3. WinDVD will check the type of the disc and play accordingly.

4. By default, a DVD title is shown in the viewing window mode. You
can double click on the screen to change the playback to full screen.
To control the playback, use the WinDVD Control Panel or shortcut
(right click) menu, or the remote control.
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Close

Full Screen
Minimize
~ (The video image below is for reference only.) —‘ |

Viewing
Window

Control Panel

Controlling WinDVD

You can use the remote control or the WinDVD Control Panel to control
WinDVD.

The WinDVD Control Panel is where the majority of the controls are
located, such as play, pause, stop, volume, speed and navigation.

While in full screen, click anywhere on the screen to access the WinDVD
Control Panel. To close the Control Panel, click the screen again.
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When you move the mouse cursor to a button or knob on the Control
Panel, a small box pops up showing its name.

The following table describes the various buttons and knobs on the
Control Panel and remote control.

Button Name Remote Descriptions
Control
A Play @ Begins the playback.
()
o Stop @ Stops the playback.
[ Pause Pauses the current playback.
@ Click the same button again or the Play

button to resume playback.

Speed Shuttle Changes the playback speed. Move the
slider upward to increase or downward
to decrease the speed.

-

i Step Forward Displays the next or previous frame of
LS Step Backward the content in a paused state.

&L  Speed Increase' Increases or decreases the playback
A=V  Speed Decrease' speed.

Speed change by this method will be
effective throughout the playback (even
when proceeding to the next chapter).

Time Clock' Causes the playback to finish within a
certain period of time or by a certain
time. When you specify the values, the
program will automatically adjust the

playback speed.
Mute <M> Toggles mute on or off.
= Repeat Sets the repeat mode to: No Repeat,

Repeat Chapter or Repeat Title.
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&€= Zoom

Zooms in to see more closely. After
clicking this button, put the magnifying
glass to where you wish to zoom in and
click. Or, drag and drop to outline the
desired zoom area.

You can then pan on a zoomed-in area
by moving the screen up, down, left or
right.

To restore to the standard view, click
the screen.

=3 Bookmark Marks a location within a video so that
you can return to that location quickly
and easily.

Capture Captures the current video frame and
opens the capture browser to save the
captured image.

Gdsrls Fast Backward/ [ <)  Fast backwards or fast forwards the

Fast Forward

F.Forward

playback. If you simply click the
button, WinDVD will fast backward or
forward until you click Play, Stop or
Pause. If you hold the mouse button
down, WinDVD will fast backward or
forward until you release the mouse
button.

Click the arrow in between to directly
select a speed.

{@isellsly Previous Chapter/ @
Next Chapter

lext Chapter

Moves to the previous or next chapter.
Click the arrow in between to directly
select a chapter.

Menu

Displays the DVD menu where you can
specify the chapter, audio, subtitle and
angle, if available.

@&  Eject

Ejects the drive tray.

= Slider Button

Moves to a different location for
playback.

Entertainment in PC Mode
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Volume

¢

Adjusts the playback volume.

2_1.08:41] Display
Panel

Displays the current status such as disc
type, the current chapter and the elapsed
time.

T Help

Opens WinDVD online help.

Minimize

Minimizes WinDVD to the tool bar.

[ |
= Full screen

Toggles between the full screen display
and window display.

» Close

Exits WinDVD.

Subpanel

Opens Subpanels for adjusting the
advanced options of the current disc.
(See “WinDVD Subpanels” in this
section for more information.)

c.c/Mem

Close Caption® <> Opens or close the caption. Caption
provides a textual equivalent of a
motion picture soundtrack for deaf and
hard of hearing audiences.

Subtitle? S%is Selects a subtitle.

Angle’ 6 Selects a viewing angle.

Audio® O Selects an audio mode.

Numeric Keys

0XOR0,

OXOX0,

GYOXO,
©

Selects a chapter number to play the
selected chapter.

Table Note:

! Speed Increase, Speed Decrease and Time Clock buttons use a technique called
“time-stretching”. With time-stretching, WinDVD can play a video from
approximately half speed to up to two times normal speed. Within this range, the video
and sound remain as smooth without any distortion. (Note that time-stretching does not
work for S/PDIF speakers, if connected.)

2 depends on the current DVD in use. Not all DVDs support the options.
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WinDVD Subpanels

The WinDVD Subpanels contain advanced options for adjusting the
current disc. When you click the button at the right side of the
WinDVD Control Panel, you can reach any of the five Subpanels. They

are:

Navigation
Allows you to navigate through the disc and select a viewing angle, if
available, for the current disc.

Language
Allows you to select the audio and subtitle language, if available, for
the current disc.

Display

Allows you to control the display settings for the current disc. You
can determine how the viewing window appears, set the aspect ratio
for DVD content that has a wide screen attribute, select the
deinterlacing technique for content that requires conversion from
interlaced to progressive scan and fix the aspect ratio.

Color
Allows you to control the color behavior of the video displayed in the
viewing window.

Audio Effect
Allows you to adjust the sound to fit your listening conditions and
personal taste.

| NOTE: Not all options are available for all DVDs.
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Shortcut Menu

9
(]
5
&3

interyi

v Play
Pause
Skop
Fast Forward
Fast Backward
Eject
Seck
Repeat

Title:
Chapter

BookmarkCapture

Source
Wideo Window
Widescreen Mods
v Plaver
L e ]
Setup...
Buy and Upgrade. ..
Activate Mow, ..
Help...
Exit

4

WinDVD Setup

When you right click the viewing screen or press the
Display button on the remote control, a shortcut menu
pops up. The shortcut menu provides an alternative to
control the DVD playback. The commands in this
menu are the same as those available in the Control
Panel.

Depending on the DVD in use, not all items are
available for setting. Unavailable items will be dimmed
in the menu. Arrows to the right side of the items
invoke submenus.

To close the shortcut menu, click anywhere outside the
menu, or select and activate an item.

You can customize how WinDVD works. For example, you can set a
password to prevent your children from watching movies rated R or

NC-17.

Your settings will become global preferences in that they affect all
DVDs, CDs and other media that you play through WinDVD. If you want
to temporarily change the way WinDVD plays back the current disc, use

the Subpanels.

To set up WinDVD, select Setup from the shortcut menu or click the
Setup button on any of the Subpanels. The Setup dialog has six tabs
as described below.

4-8
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Preferences

In the Preferences tab, you can configure the followings:

e Source configuration

e DVD default configuration (audio language, subtitle language and
subtitle/CC style)

e Parental playback control

Control

In the Control tab, you can determine the behavior of the Control Panel
such as:

e The Control Panel can autohide after x seconds, show or hide in full
screen viewing mode.

e Bookmark/capture configuration

e Control timing configuration

Audio

The Audio tab lets you set audio preferences such as output, speaker
configuration and sub woofer control. The settings depend mainly on
your hardware. If you need to change the audio settings during the
playback of a disc, use the Subpanel.

Video

You can make a DVD to automatically play in full screen.

Region

To determine the region for which a DVD disc is designed, look in the
middle of the disc for a small standardized globe icon indicating the
region number. If a disc plays in more than one region, it will have more
than one number on the globe. If a disc does not have any regional
coding, the disc should have a globe with ALL instead of a number or no
globe icon at all.

There are six regions:
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1 USA, Canada

2 West Europe, Japan, South Africa
3 South East Asia

4 Australia, Spanish America

5 Russia, East Europe, Africa

6 China

Most DVD drives will let you change your designated region a total of
five (5) times before the setting becomes permanent. If settings have
already been changed, you will have fewer than that. Before you select
your last regional change you will be given a special warning. Once you
have made the last choice of last regional setting, you will not be able to
play DVD discs from any other region.

The first time that you play a regionalized DVD the region is
automatically set to match the region of the disc. If you later try to play a
disc from a different region, WinDVD will ask you if you want to change
the region setting. Click OK to change to the new region. Normally, you
cannot change the region while a disk is playing.

The number of region changes made in the past has been recorded by the
drive itself and not by the WinDVD software.

| CAUTION: There is no way to reset this value, so be careful.

Information

The Information tab provides hardware-related information for your
reference. The information can be helpful when you want to set up your
own preferences.

File Playback

WinDVD can play video and audio files. This lets you take advantage of
the WinDVD features while watching your personal audio or video
content.

The file formats supported are:

e Video File Types
ASF, ASX, AVI, MPG, MPEG, M2V, VOB, DAT

4-10
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e Audio File Types
AC3, DAT, M2A, M2P, MP2, MPG, MPEG, MP3, M3U

You can view files by drag-and-drop or by using a playlist.

Drag and Drop

WinDVD lets you drag your favorite files form your desktop onto the
WinDVD Control Panel. Simply drag the icon for one or more audio or
video files onto the WinDVD icon or Control Panel. WinDVD
automatically begins playing the files.

Using Playlists

Playlists are custom lists of media files to play and the order in which to
play them. WinDVD allows you to create lists that mix different types of
media. Any file type supported by WinDVD can be added to a playlist,
including entire discs. You can save playlists and load them again for
replay at any time.

To create a playlist:

1. Select the New Playlist command from the Source menu on the
Navigation Subpanel.

2. In the lower left of the Playlist window, select File to allow file
selection or Disc to allow playback of entire discs.

3. Use the browser to highlight files or discs you want to include in the
playlist. Click Add.

4. Once you have added all your selection, you can save the list or
simply play it by clicking OK.

5. To save the playlist, click Save Playlist and give it a name.

Once you have created and saved a playlist, you can load it into WinDVD
for playback. To play a playlist:

1. Select the Playlist command from the Source menu on the
Navigation Subpanel.

2. Click Load Playlist to load a saved playlist.
3. Select the playlist to load and click Open.
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4. Click OK and WinDVD plays the files in the order they appear in the
playlist.
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WinFast PVR: Watching TV

If your model has the TV card installed, you can use the WinFast PVR
program to watch TV in PC mode.

NOTE: To watch cable TV, you need to have an account with a cable TV provider and
connect the cable to your system.

WinFast PVR is a powerful and easy-to-use application that provides the
most feature-rich video entertainment. WinFast PVR allows you to view
and record live TV or video, and play back recorded TV or video in a PIP
(picture-in-picture) style as well as control all available functions.

This section provides basic operating instructions. For advanced
operations, refer to the WinFast online help where you can find the latest
and complete information.

Watching TV

| NOTE: You can not use WinFast PVR and WinFast FM at the same time.

1. You can start WinFast PVR by either of the following ways:
e Click Start > Programs > WinFast Entertainment Center >
WinFast PVR.
e Press the TVIVCR button on the remote control.

2. A window with live TV broadcast and Control Panel will appear on
the screen. You can switch channels by:
e Using the + and — buttons on the Control Panel.
e Pressing the Ch+ or Ch— button on the remote control.
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Minimize

Close
(The video image below —‘

Adjust the
window width.
is for reference only.)

Viewing window

Adjust theJ
window height.

|— Adjust the
window height.

Control Panel

.

R se

Scanning TV Channels

When you use WinFast PVR for the very first time, you must scan the
available TV channels in your area before you can watch TV.

You can scan the TV channels by either of the following ways:

e On the WinFast PVR Control Panel, click the @ Configuration
button > (& Tuner Setup button > Scan Channels button.
WinFast PVR will start scanning and display channel numbers on the
channel list.

o Press the Scan button on the remote control.
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Watching TV in Full Screen

When you watch TV, you can switch between full screen and viewing
window by double clicking or selecting from the shortcut (right click)
menu.

NOTE: You can schedule a TV event in advance to make WinFast PVR automatically
broadcast a show at the scheduled time. (See “Scheduling TV Events” later in this
section.)

Controlling WinFast PVR

You can use the WinFast PVR Control Panel or the remote control to
control WinFast PVR.

WinFast PVR Control Panel provides all the basic operations such as
switching channels, volume control and recording.

When you move the mouse cursor to a button on the Control Panel, a
small box pops up showing its name.

The following table describes the various buttons on the Control Panel
and remote control.

0 606006 00 o6
AL am
(1] =
CH 74 P
X o
© ©®© ® ® ® @
Ref Button Name Remote Descriptions
Control
© Status Window Displays current TV status such as

current mode and channel number.
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FM Switch

TVIVCR

Switches to WinFast FM for listening to
FM radio. (See the next section for
information.)

Help

Opens WinFast online help.

Minimize

Minimizes the Control Panel to the tool
bar. Only the CH-, CH+ and Volume
buttons remain visual on the bottom left
corner of the viewing window.

Exit WinFast PVR

Exits the WinFast PVR program.

Mute

Toggles mute on or off.

Volume

Controls the volume level, indicated by
colors ranging from blue (low) to red
(high).

Record

Records the live TV broadcast. (See
“Recording Live TV and Playing Back”
later in this section.)

Time Shift

Records and then plays back while
recording. (See “Time-Shifting” later in
this section.)

Snapshot

Takes a snapshot and saves it as a .bmp
file in the C:\WinFast WorkArea folder
(default setting).

Open Media File

Opens an explorer window for you to
browse for the media file you wish to
play. Double click on the file to play.
(See “Recording Live TV and Playing
Back” later in this section.)

Configuration

Opens the WinFast PVR Setup dialog
box with 4 tabs. (See “WinFast PVR
Configuration” later in this section.)

Channel
Up/Down*

-~
A4

Goes to the previous or next channel.

Input Source

TVIVCR

Switches to a different video input source
(TV, S-video or AV).
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C.C/Mem

Opens or closes the caption if supported
by the TV broadcast. Caption provides a
textual equivalent of a TV show
soundtrack for deaf and hard of hearing
audiences.

Close Caption

O

MTS

Switches the audio mode.

In NTSC systems, the available options
are SAP, Stereo and Mono.

(select models only)

MTS

&

Angle/Scan

Initiates the scanning mode to search for
TV channels available in your area.

Scan

Switches to a channel by selecting a
number.

Numeric Keys*

QOO
e

OeE

Jump/Shuffle

Jump O Switches to the channel last accessed.
Display DWCSW Displays the current channel number.
Stop @ Stops the playing/recording, or exits the
playback mode.
Play/Pause S Begins or pauses the playback of the
@ recording.

Fine Tune Up/ If the signal quality is not good, you can
Fine Tune Down fine tune the channel by searching up or
down by 62.5 KHz at a time.

©
O

Table Note:

* In PC mode, only the favorite channels are accessible if you have activated the use of
favorite channel list using the WinFast PVR program. Otherwise, all channels are
accessible.

Managing TV Channels

By default, you surf through TV channels by numbered sequences. For
quick and easy access, you can set up your favorite channel list, name the
channels and change the channel sequence.

Entertainment in PC Mode 4-17



On the WinFast PVR Control Panel, click the @ Configuration button
and then the &) TV Tuner button. The channel list appears on the
screen.

[ @ W zmier Braz
e k- R

(%) (e o (e

Using Favorite Channel List

In the channel list, favorite channels are marked with a ‘+” in a heart
shaped icon. They are the channels accessible when you switch channels
with the Channel Up/Down button.

After your first scanning, all available channels are favorite channels by
default. If you do not want to surf through too many channels, you can
minimize the total number of favorite channels. To do so, select in the list
the channel that you do not want and right click the mouse to pop up the
shortcut menu. Uncheck Favorite Channel in the shortcut menu. The
icon of the channel will become a spade with a ‘—’.

NOTE: You can toggle on or off the favorite channel list by right clicking the WinFast
PVR Control Panel and uncheck Use Favorite Channel List in the shortcut menu.

Naming the Channels

To easily identify the channels, you can name the channels so that the
channel names will appear in the status window.
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To name a channel, you can click on a channel name to rename it as you
do in any Windows explorer. You can also change a channel name by
selecting Edit This Channel Name from the shortcut (right click) menu.

Changing the Channel Sequence

You can change the channel sequence in the list. For example, you can
gather all your favorite channels together at the beginning of the channel
list.

To change the sequence, select in the list the channel that you want to
move and click the up or down arrow at the right side of the dialog box.

Time-Shifting

“Time-shifting” is a useful feature. It can always happen that you have to
leave for a while when watching live TV, but you just do not want to miss
any part of it. At this time, you can use the time-shifting feature.

1. Before you leave, do either of the following:

e Click the @ Time Shift button to start recording.
e Press the Time Shift button on the remote control to start recording.

2. When you are back, do either of the following:
e Click the “g= = Play button.
e Press the Play button on the remote control.

The screen displays PIP (Picture-In-Picture). By default, the
playback appears on the main screen and the live TV appears on the
sub screen.
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(The video image below is for reference only.)

00:08:04'83"
TimeShifting

3. In time-shifting mode, you can:
e Cancel PIP mode — Right click the viewing window and uncheck
Picture-in-Picture in the shortcut menu.
e Swap PIP — Right click the viewing window and click Switch
Screen in the popup menu.
e Move the sub screen to a different location and resize it.

| NOTE: You can only hear the sound of the main screen in PIP mode.

4. To end time-shifting, do either of the following:
e Click the @ Exit button.
e Press the Stop button on the remote control.

CAUTION: Recording by time shifting will not be saved as a permanent file. A
temporary hard disk space is continuously overwritten as time-shifting goes on. The
longer the interval between the time when the recording begins and the time when the
playback begins, the larger the hard disk space is required. When the hard disk space
is used up, the recording will be terminated.
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Recording Live TV and Playing Back

CAUTION: During the recording, do not change the status of the program. If you switch
to another channel, the recording will be switched to the new channel. If you switch to
WinFast FM, the recording will be switched to the radio broadcast.

Recording

You can start recording the live TV broadcast by either of the following
ways:

e C(Click the Record button at the right side of the WinFast PVR Control
Panel to record the current live TV broadcast. The button turns red to
indicate that the recording is in progress. To stop the recording, click
the same button again.

e Press the Record button on the remote control to start recording the
current live TV broadcast. To stop the recording, press the Stop
button on the remote control.

The screen displays PIP (Picture-In-Picture). By default, the playback
appears on the main screen and the live TV appears on the sub screen.

By default, the recording will be saved in C:\WinFast WorkArea folder as
a MPEG-2 file and the file name will contain the date and other numbers
determined by the system.

CAUTION: In general, the file size of a 1-minute recording is approximately 40MB
using the default quality settings. However, the complexity of the video can also affect
the file size. During the recording, if the hard disk space is used up, an error message
will appear on the screen and the recording will be terminated, resulting in incomplete
contents in the file.

NOTE: If your model has a Combo drive, you can create a video CD by duplicating the
recording files to a CD-R/CD-RW. (See “B’s Recorder” in Chapter 6 for details.)

Playing Back Recorded TV

You can play back recorded TV or open video files with WinFast PVR.

On the Control Panel, click the @ Open Media File button and select
the file you want to play back. WinFast PVR will turn into TV playback
mode.
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During the playback, you can conduct basic controls such as fast forward,
fast backward, pause and stop using the Control Panel or the remote
control.

Pause/Play

Switch panel
Current filename Fast backward —‘

Fast forward

B Live TV 29-1755.TV62).avi
Elapsed timel—ﬂﬂ:ﬂu:ﬁﬁ*ﬂl' 1.00x
Playback mode ————FLAVEACK

\i Exit playback mode.
Stop

To stop the TV Playback mode, click the Exit button, or press the Stop
button on the remote control.

Scheduling TV Events

You can schedule a TV event so that the live TV at the specified time is
recorded or played.

Follow this procedure to schedule an event:

1. On the WinFast PVR Control Panel, click the e Configuration
button and then the . TV Scheduler button. The schedule list
will appear on the screen.

2. Click Add button to open the TV Scheduler dialog box.
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Action Starting Date
Charnel

& wWarner Bros -

Ending Date Ending Tirme
< Dwration

Capture Format Profile gle Time 1 Hour 0 Sec

Bl MPEG-2 Good Guality
mrments

MTS Felicity Interrupted; Back ta
the Future|
-

Captured Filename
Back to the Future

3. Enter the information for these fields:
Action — Select either TV Record or TV Show.
Channel — Select the desired channel from the pull-down list.
Captured Filename — Enter a file name. If not entered, the filename
will be determined by the program.
Starting/Ending Date — Enter the date of the TV show.
Starting/Ending Time — Enter the time of the TV show.

Enter other information if necessary.

Click the OK button to confirm and return to the previous screen.

A A

The event will appear in the list. Click the v button to save.

CAUTION: Make sure that the system is in PC mode with power saving disabled before
the scheduled event starts. The action will not be performed if the system is off or in AV
mode.

7. Just a few seconds before the scheduled time, your system will
automatically start the WinFast PVR program to perform the action
as requested.

WinFast PVR Configuration

You can configure the TV device properties, quality setup, tuner setup
and scheduler when necessary. Click the @ Configuration button on the
WinFast PVR Control Panel to access the dialog box with 4 tabs as
described below.
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Device Setup

You can select from the 10 profiles of formats built in the program. If
necessary, you can create your own set of format. In this tab, you can
also set Time Limit or Size Limit for recording.

Quality Setup

This tab lets you set the brightness, contrast, hue, saturation and color
scheme of the viewing window.

Tuner Setup

This tab lets you scan and configure the TV channels. (See
“Managing TV Channels” earlier in this section.)

Scheduler @

This tab lets you schedule a TV Record or TV Show. (See
“Scheduling TV Events” earlier in this section.)
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WinFast FM: Listening to FM Radio

If your model has the TV card installed, you can use the WinFast FM
program to listen to FM radio in PC mode.

CAUTION: Make sure that the FM antenna is connected. If the signal quality is not
good, try relocating the antenna.

This section provides basic operating instructions. For advanced
operations, refer to the WinFast online help where you can find the latest
and complete information.

Listening to FM Radio

| NOTE: You can not use WinFast PVR and WinFast FM at the same time.

1. You can listen to FM radio by either of the following ways:
e Click Start > Programs > WinFast Entertainment Center >
WinFast FM.
e Press the FM. Radio button on the remote control.

2. The WinFast FM Control Panel will appear on the screen. You can
click the Control Panel buttons or press the buttons on the remote
control to select a channel for listening to.

Scanning FM Channels

When you use WinFast FM for the very first time, you must scan the
available FM channels in your area before you can listen to FM radio.

You can scan the FM channels by either of the following ways:

e On the WinFast FM Control Panel, click the @ Configuration
button > Tuner Setup button > Scan button. WinFast FM will
start scanning and display channel numbers on the channel list.

NOTE: You can set the sensitivity of the scanning by changing the sensitivity level
between 1 and 3. If it is set too high, noise can be mistaken for a radio station.

e Press the Scan button on the remote control. (Refer to the procedures
in “Saving Favorite FM Channels” in Chapter 3 to manage FM
channels with the remote control in PC mode.)
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NOTE: You can schedule a radio event in advance to make WinFast FM automatically
broadcast the show at the scheduled time. (See “Scheduling Radio Events” later in this
section.)

Controlling WinFast FM

You can use the WinFast FM Control Panel or the remote control to
control WinFast FM.

WinFast FM Control Panel provides all the basic operations such as
switching channels, volume control and recording.

When you move the mouse cursor to a button on the Control Panel, a
small box pops up showing its name.

The following table describes the various buttons on the Control Panel
and remote control.

92.10MHz [ [#]

01:47:33 FM

a's'aT]ale

F

(&

Ref Button Name Remote Control Descriptions

(1) /@ & @ If you have created your favorite channel
h list, you can click the CH+ button to switch
@" to the next favorite channel and the CH—

= button to the previous.

& A v Searches for the previous or next available
e FM channel.
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If signal quality is not good, you can fine
tune the channel by searching up or down
by 0.05 MHz at a time.

Add a favorite channel. (See “Managing
FM Channels” later in this section.)

TVIVCR

@® TV Switch Switches to WinFast PVR for watching TV.
(See the previous section for information.)
© Help Opens WinFast online help.
O Minimize Minimizes the Control Panel to the tool bar.
© Exit WinFast Exits the WinFast FM program.
™M
® Slider Searches available channels.
@ Status Shows the current radio status such as the
Window current channel, frequency, station and
time.
® Mute MO Toggles mute on or off.
© Volume Controls the volume level, indicated by
colors ranging from blue (low) to red (high).
@® Record Records the live FM broadcast. (See

“Recording Live Radio and Playing Back”
later on in this section.)

@ Open Media
File

Opens an explorer window for you to
browse for the media file you wish to play.
Double click on the file to play. (See
“Recording Live Radio and Playing Back”
later on in this section.)

® Configuration

Opens the WinFast FM configuration
dialog box with 3 tabs. (See “WinFast FM
Configuration” later in this section.)

® Favorite
Channels

QOO
OO

OO

After setting up favorite channels, click a
corresponding number to switch to a
favorite channel.
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Memory N Saves the current channel as a favorite
channel. (See a later subsection for details.)

Scan o Initiates the scanning mode to search for
FM channels available in your area.

Jump J@‘e Switches to the channel last accessed.

Enter Executes your selection.

Stop @ Stops the scanning mode or the

recording/playback.

Managing FM Channels

For easy and quick access, you can name the FM radio channels, set up
favorite channels and group the channels.

By default, the first 10 channels scanned are favorite channels. You can
find the numbers 1 to 10 in the “Preset” column of the channel list. They
indicate the channels that are assigned to the number buttons on the
WinFast FM Control Panel or the numeric keys on the remote control.

In addition, you can have up to 3 groups of favorite channels. When you
activate one of the groups by selecting from the right click menu, the
CH+ and CH- buttons on the Control Panel / Up and Down arrows on the
remote control will cycle among this group of favorite channels only.

To configure the channels:

1. On the WinFast FM Control Panel, click the @ Configuration
button and then the FM Tuner Setup button. The channel list
appears on the screen.
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Freqguenc
@ riew Channel 107.70 MHz
@ riew channel 107.70 MHz
W Hew Channel 100,70 MHz
W hiew Channel 97.70 MHz
@ riew Channel 101,70 MHz
@ riew Channel 101.70 MHz

@ riew Channel 100,70 MHz
W Mew Channel 100,70 MHz
W hiew Channel 97.70 MHz
@ riew Channel 104,70 MHz
@ riew Channel 104,90 MHz
@ riew channel 103.20 MHz
W Hew Channel 87,60 MHz
@ tiew Channel 88.10 MHz
@ riew Channel 90,10 MHz
@ iew Channel 91.30 MHz

2. Click the channel you wish to edit.

NOTE: You can also right click on a channel to make changes through the shortcut
menu.

3. Click the Edit button and a dialog box appears as shown below.

Mame Frequence

Mews Channel 76.00 |k

4. Select a number for the “Preset” field. This will assign the channel to
the number button of the Control Panel.

5. To name the channel, enter the name for the “Name” field.
6. Click OK to close the dialog box.

7. 1If you wish to specify the channel to a favorite group, right click the
channel and click Set Favorite Channel Group to select a group
number. The number in the heart-shaped icon indicates which group
a channel belongs to.
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NOTE: If you wish to assign the same channel to different groups, you need to add the
channel to the list again.

8. Click the Y button to save and close the dialog box.

Recording Live Radio and Playing Back

CAUTION: During the recording, do not change the status of the program. If you switch
to another channel, the recording will be switched to the new channel. If you switch to
WinFast PVR, the recording will be terminated.

Recording

You can start recording the live FM broadcast by either of the following
ways:

e Click the Record button at the right side of the WinFast FM Control
Panel to record the current live FM broadcast. The button turns red to
indicate that the recording is in progress. To stop the recording, click
the same button again.

e Press the Record button on the remote control to start recording the
current live FM broadcast. To stop the recording, press the Stop
button on the remote control.

By default, the recording will be saved in C:\WinFast WorkArea folder as
a WAV file and the file name will contain the date and other numbers
determined by the system. To play back the file, open the file as described
below.

CAUTION: In general, the file size of a 1-minute recording is approximately 3MB using
the default quality settings. If the hard disk space is used up, an error message will
appear on the screen and the recording will be terminated, resulting in incomplete
contents in the file.

NOTE: If your model has a Combo drive, you can create an audio CD by duplicating the
recording files to a CD-R/CD-RW. (See “B’s Recorder” in Chapter 6 for details.)

Playing Back Recorded Radio

You can play back recorded radio or open audio files with WinFast FM.
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NOTE: You can not use the remote control to open and play back the recorded radio or
audio files.

On the Control Panel, click the ©) Open Media File button and select
the file you want to play back. Click the ‘42> Play button to play back
the file.

During the playback, you can conduct basic controls such as fast forward,
fast backward, pause and stop using the Control Panel.

Playback volume control Switch panel

Filename

Play/Pause

EhRadio

P 53713 way  O2- =F

I CIERE E.'-J'J o

- | N —_— -

Playback mode Stop

Scheduling Radio Events

You can schedule a radio event so that the live radio at the specified time
is recorded or played.

Follow this procedure to schedule an event:

1. On the WinFast FM Control Panel, click the €) Configuration
button and then the @ FM Scheduler button. The schedule list
will appear on the screen.

2. Click ADD button to open the FM Scheduler dialog box.
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3. Enter the information for these fields:
Action — Select either Radio Record or Radio Show.
Channel — Select the desired channel from the pull-down list.
File Prefix — Enter a file name. If not entered, the filename will be
determined by the program.
From/To— Enter the start and end date and time of the radio show.
Daily— Check this field for a daily event. Check a week day for a
weekly event.

Enter the other information if necessary.

Click the OK button to confirm and return to the previous screen.

A

The event will appear in the list. Click the Y button to save.

CAUTION: Make sure that the system is in PC mode with power saving disabled before
the scheduled event starts. The action will not be performed if the system is off orin AV
mode.

7. Just a few seconds before the scheduled time, your system will
automatically start the WinFast FM program to perform the action as
requested.

WinFast FM Configuration

You can configure the FM radio device properties, tuner setup and
scheduler when necessary.

Click the @) Configuration button on the WinFast FM Control Panel to
access the dialog box with 3 tabs as described below.
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e Device Setup

The setup is related to the hardware. Unless you have specific needs,
avoid changing the settings. In this tab, you can also specify the file
prefix for the recording files and directory for saving the files to.

e Tuner Setup EE)

This tab lets you scan and configure the FM channels. (See
“Managing FM Channels” earlier in this section.)

e Scheduler @
This tab lets you schedule a Radio Record or Radio Show. (See
“Scheduling Radio Events™ earlier in this section.)
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CHAPTER 5

Expanding Your System

You can expand the capabilities of your system by connecting external
peripheral devices. When using a device, be sure to read the instructions
accompanying the device together with the relevant section in this
chapter.

This chapter gives guidelines on installing and using these devices:

USB device

IEEE 1394a device
Audio devices

Video devices

PC Card
SM/MMC/SD/MS card



Connecting a USB Device

Your system has four USB ports for connecting USB devices such as a
keyboard, mouse, printer, modem, scanner and digital camera.

USB (Universal Serial Bus) supports “Plug and Play” technology so you
can install and remove USB devices without turning off the system. With
its multiple connection capability, up to 127 devices can be connected in
a daisy-chain configuration. In addition, you can use a USB hub that
converts a single USB connector into multiple ports where USB devices
can be connected.

Your USB ports support these two standards:

e USB v.2.0 with transfer rates up to 480MB/s (The USB 2.0 driver
supplied with your system must be installed.)

e USB v.1.1 with transfer rates up to 12MB/s

To connect a USB device, simply plug the device cable to one of the USB
ports.
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Connecting an |[EEE 1394a Device

Your system has a standard and a mini IEEE 1394a port.

IEEE 1394 is the next-generation serial bus standard, featuring high-
speed data transfer, multi-channel communication link, and “Hot Plug”
connectivity. It allows connection of up to 63 devices. The applications
include not only computer peripheral devices such as scanner, printer and
high-quality CCD, but also consumer electronic equipment such as
DVCAM and VCR.

To connect a 1394a device, simply plug the device cable to the IEEE
1394a port of the system.

AnaannANANNAANANNAAN AN ARARARAAAARANAANN
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Connecting Audio Devices

CAUTION:

o The audio driver supplied with your system must be installed to ensure normal
operation of the audio features.

o After connecting an external audio device, make sure that you specify the use of
the correct audio device in Windows XP.

For higher audio quality, you can send or receive sound through external
audio devices.

Microphone Connector ( ﬁ\ ) can be connected to a microphone for
recording voice or sound.

Audio Input Connector ( (¢ ) can be connected to a Hi-Fi set, radio
set, synthesizer, walkman, etc for audio input.

Audio Output Connector ( (- ) can be connected to the line-in
connector of powered speakers with built-in amplifiers, headphones,
or earphone set. When connected, the internal speakers are disabled.

AnNAAAANAANaNNRRARAGN N NNNANARANARAAAAARAA
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e S/PDIF Output Connector can be connected to a S/PDIF
(Sony/Philips Digital Interface) device such as a digital speaker set
for digital audio output. S/PDIF is a new audio transfer file format,
which provides high quality through optical fiber with digital audio.

NNNNNNNANANANANANNANANNNNAAAAAAAAAAAANANAD
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NOTE:

e The S/PDIF connector is classified as a Class 1 laser product.

e Remove the plug in the S/PDIF connector before connecting a S/PDIF device.
Replace the plug when not using a S/PDIF device.

o When using S/PDIF speakers, the internal speakers and S/PDIF speakers both
send out sound. In PC mode, you can mute the internal speakers using Windows
XP Control Panel. In AV mode, you cannot mute the internal speakers.
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Connecting a Video Device

If your model has the TV card installed, you can connect an external
video device such as a camcorder, VCR and video game console for
video input.

1. Make sure that the system is turned off.

2. Plug the AV/S video cable to the Video Input Connector on the right
side of the system.

3. Depending on the type of the video device to be connected (S-video
or AV), prepare the necessary cables.

4. Ifyou are connecting an AV device:
There are usually three cables (one video and two audio cables) to be
connected. The connector types are identified by colors: red for LINE
IN R, white for LINE IN L and yellow for VIDEO IN. Plug the
yellow connector to the AV/S video cable. The audio cables should
connect to the system’s audio input connector. (You may need a Y-
type adapter.)

AV/S video cable

S
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If you are connecting an S-video device:
Plug the cable from the device to the S-video connector on the AV/S

video cable.

AV/S video cable
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Using PC Cards

Your system has a PC Card Type II slot.

PC Cards are credit card-sized peripheral products based on the standards
developed by PCMCIA (Personal Computer Storage card International
Association). PCMCIA is a non-profit association for promoting the
interchangeability among mobile computers where ruggedness, low
power, and small size are critical.

Your PC Card slot supports CardBus specifications. CardBus is the 32-bit
version of PC Card technology. It allows speeds of up to 133 Mbps at 33
MHz. Typical applications are SCSI host bus and high-speed network
cards.

Inserting and Removing a PC Card

NOTE:

o Some PC Cards require additional system resources. Before using such PC Card,
you may have to free other system resources for the PC Card.

o Although some PC Cards can be inserted and removed without turning off the
computer, you cannot remove or install PC Cards during Standby mode.

To insert a PC Card:
1. Locate the PC Card slot on the left side of the system.

2. Slide the PC Card, with its label facing the front of the system, into
the slot until the eject button pops out.
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Eject Button

Ly

3. When a PC card is seated, the computer will detect it and try to install
the appropriate driver. Follow the on-screen instructions to complete
the process.

To remove a PC Card:

1. Before removing the PC Card, you should first stop it in Windows
XP. To stop the PC Card, double-click the ‘§ Safely Remove
Hardware icon in the tool bar, select the PC Card and then click
Stop. Windows will attempt to stop the device.

2. When Windows notifies you that it is safe to unplug the device, push
the eject button to release the button, push the button again to release
the PC Card and then pull the card out of the slot.
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Using the Card Reader

NOTE:

o To take advantage of the Card Reader, the Card Reader driver supplied with your
system must be installed.

o Ifyour hard disk is divided into several drives, make sure that all drives have been
formatted before using the Card Reader. Otherwise, you may encounter problems
when using the Card Reader.

e You can use only storage cards. Your Card Reader does not support cards with I/0
functions such as a wireless network card or bluetooth card.

Depending on your model, your system may have a Card Reader. The
Card Reader is a small drive for reading from and writing to removable
storage cards (or called memory cards). The cards supported are
SmartMedia (SM), MultiMediaCard (MMC), Secure Digital (SD) and
Memory Stick (MS) cards.

Shown below are the appearances and sizes of each card type for your
reference.

Secure Memor

Type SmartMedia MultiMediaCard Digital Stick

Appearance

rd

T pe
o

SmartMedia

Size 37x45x0.76 24x32x1.4 24x32x2.1 21.5x50x2.8
(mm) (mm) (mm) (mm)
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To insert a storage card:

1. Locate the Card Reader slots on the left side of the system. The front
slot accepts a SM card and the back slot accepts a MMC/SD/MS card.
You can only use one card at a time.

2. Align the card with its connector pointing to the corresponding slot
and its label facing the front of the system. Slide the card into the slot
until it reaches the end.

SM Card

3. Windows XP will detect the card and assign it a drive name (typically
E).

To remove a storage card:

1. Double-click My Computer.

2. Right-click on the drive with the card and select Eject.
3. Pull the card out of the slot.
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Internal Components Upgrade

You can upgrade your system by changing the CPU or adding memory.
However, to avoid damage during the installation procedure, please ask
your dealer for help. Do not install an internal component by yourself.

| CAUTION: Unauthorized modifications to the system can void your warranty.
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CHAPTER n

Driver and Software CDs

Supplied with your system is a Driver CD containing basic drivers and
bundled software for your system. Other CDs may also be available
depending on your model.

This chapter describes how to use the CD(s) supplied with your system.



Driver CD

NOTE:

e The Driver CD supports Windows XP only.

e You can always find Readme or text files on the CD. These files contain the latest
information from the manufacturer. Please read the files together with this chapter.

o The Driver CD may have been updated after this manual was published. For Driver
CD upgrade, please contact your dealer.

o To ensure normal operation of your system’s home entertainment features, do not
install other multimedia programs similar to those bundled with your system.

The Driver CD contains:

e Drivers
Drivers are custom software that function as a layer between the
operating system and a system component. The operating system
needs the drivers to recognize and take full advantage of a component
in your system.

e Multimedia application programs
Bundled with your system are WinDVD, WinFast PVR and WinFast
TV programs for multimedia applications.

e Instant Play
Instant Play is the software that allows you to use your system as a
consumer home appliance in AV mode.

If you purchased your system with Windows XP pre-installed, your
dealer may have already installed the drivers and software for you. If not
or if you need to re-install a driver or program, use the Driver CD.
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Installing Instant Play

“Instant Play” is the software that needs to be installed for using your
system in AV mode.

Your system should have come to you with /nstant Play preinstalled. In
case you reformatted your hard disk drive and have to re-install
everything, Instant Play is the first one to install. Follow this procedure to
install Instant Play before installing Windows XP:

1.

Set the CD-ROM drive as the booting device following this

procedure:

a. Press the power button to turn on the system.

b. When the message “Press <F2> to enter System Configuration
Utility” appears, press F9 to invoke the boot device menu.

c. Press the T or { key to move the highlight to CD-ROM.

d. Press the Space bar to select.

Insert the Driver CD.
Press Enter to boot from the CD.

When the system boots from the Driver CD, a Greetings screen
appears to guide you through the Instant Play installation process.
Press Enter to continue.

Press Tab to select your preferred language. Press Enter to continue.

Press Tab to select a region according to your location. Press Enter to
continue.

| NOTE: If the region setting is incorrect, the TV function may not work properly.

7.
8.

After confirming the language and region, press Enter to continue.

When the installation is completed, you will be prompted to press
OK to power off the system.
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Installing Drivers and Multimedia Application Programs

An autorun program is provided on the Driver CD to help you easily
install the drivers and multimedia application programs. While in
Windows XP, insert the Driver CD and the autorun program
automatically starts. If you need to start the program manually, run the
Setup.exe program on the CD. The main screen appears as shown next.

Windows XP Setup

o
e
®
g
L=

To install a driver or program, just click on the corresponding icon and
the installation will start. The icons on the screen are described next:

NOTE: Depending on the model you purchased, you may not see all the icons as
shown above.

Icon Name Description
E Chipset Ensures the full function of all the other drivers. You
driver must install this driver before installing the other
drivers.

'EI' Video driver  Allows you to take full advantage of the video
Nt features.
NOTE: When installing the video driver, the screen
may blank for 10 to 20 seconds. Please wait until the
screen restores. This does not affect the operation.
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) Audio driver  Allows you to take full advantage of the audio
HJD features.
@ Modem Allows you to use the modem of the system.

driver
3 LAN driver  Allows you to use the network function of the system.
L7 Card Reader  Allows you to use the Card Reader to access optional
W driver SM/MMC/SD/MS cards.

TV/FM Allows you to use the TV card (select models only).

driver *

WinFast * Installs the WinFast PVR and WinFast FM for
watching TV and listening to FM radio (select models
only).

WinDVD *  Installs the WinDVD program for playing DVDs

(select models only).

MESB driver

Allows you to use the Multimedia Easy Start buttons
(MESB) for multimedia features.

VRO ® O

USB Wake-  Enables to system to wake up from Stand By mode
up driver when connecting a USB keyboard/mouse.
Q Browse CD  Browses the contents of this CD.
Table Note:

* Select models only.
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B’s Recorder

If your model comes with a Combo drive, a program called B’s Recorder
GOLD is supplied with your system. B’s Recorder includes two
programs:

e B’s Recorder GOLD
This is CD-R/RW disc recording software that provides you with a
variety of ways to create original data, audio and video CDs. It also
allows you to duplicate entire CDs or backing up your hard disk.

e B’s CliP
This program uses the packet writing method to write data by file
onto a CD-RW disc as you would onto floppy or other removable
disks. However, discs that are formatted and written using B’s CIiP
can only be read on drives that support B’s CIiP.

This section briefly introduces the functions and operations of B’s
Recorder GOLD. For detailed information, see the online help by
pressing F1 or clicking Help > Manual.

Installing B's Recorder GOLD

Insert the program CD into the CD/DVD driver and run the Setup.exe
program on the CD. Follow the onscreen instructions to complete the
installation.

After installation, the B’s Recorder GOLD program icon will appear on
Windows XP desktop.

Functions of B's Recorder GOLD

e Creating a Data CD
A data CD, which includes programs and files, can be created in
1S09660, the standard CD-ROM format.

e Creating an Audio CD
An audio CD can be created using CDA, AIFF, MP3, TwinVQ and
sampling rate 44.1kHz, 16 bit, stereo wave audio files.
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e Creating a Video CD
A video CD can be created using MPEG data that complies with the
video CD standard.

e Duplicating an Entire CD
The Disc Duplicate function allows you to make copies of an entire
CD.

e Creating Mixed-Mode and CD Extra Discs
In Mixed-Mode, the first track is file data while the second track is
audio data. The high quality audio and data files can only be used on
computers. CD Extra is the format where the first track is audio data
while the second track is file data. The audio track can be played on a
consumer CD player and the data read on CD-ROM drives.

e Direct Cut Function
The Direct Cut function will digitize analog sound from a
microphone or LP player into wave format and also record it directly
onto a CD.

e Creating a Video/CD-I Disc from an Image File
A video or CD-I disc can be created using an image file of video CD
data or CD-I data edited using authoring software.

e Creating an Image File
You can save all files entered in the fields as an image file. You can
also extract the contents of data and audio CDs by track. Audio CD
tracks can be extracted as wave, MP3 or TwinVQ files.

e Erasing the Contents of a CD-RW Disc
If you are using a CD-RW drive, you can erase the contents of a
CD-RW disc and record onto it again as a blank disc.

e Backing Up a Hard Disk
You can back up the entire contents of a hard disk onto CD-R/RW
discs. The backed up contents can be restored using the restore
function.

e Using CD TEXT
You can record the artist name, album title and song title information
along with audio data when creating an audio CD. This information is
displayed on CD TEXT compatible audio CD players. You can also
retrieve the CD TEXT information for free by accessing the CDDB
(audio CD database) Website on the Internet.
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e Maintenance Functions
The Disc Rescue function will search and restore a CD that contains
recording errors. Use the Drive Self-Diagnosis function should the
drive seem unstable during recording.

Launching and Quitting B’s Recorder GOLD

| NOTE: If you need to reinstall B's Recorder GOLD, insert the program CD in the CD-
ROM drive and run the Setup.exe program on the CD.

To launch B's Recorder GOLD, double click the program icon on
Windows XP desktop or click Start > Programs > B.H.A. > B’s
Recorder GOLD > B’s Recorder GOLD.

To quit the application, select Quit from the File menu.

The Wizard

The first time you launch B’s Recorder GOLD after installation, the
Wizard menu, which consists of the most used functions, will appear.
Follow the Wizard’s instructions to easily enter the necessary data and
complete any procedure you wish to execute.

‘Welcome to B's Recorder GOLDS!

Select one of the following operations.
An explanation appears when you move the cursor over
the button.

e G

Data

Click Close to close the Wizard window. To reopen it, click the Wizard
button on the Application window.
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The Application Window

The first time you launch B's Recorder GOLD after installation, the
application window appears behind the Wizard menu. Close the Wizard
to use the application window. All B’s Recorder GOLD functions can be
accessed from this window.

@ B's Recorder GOLDS - New Project
Ele Edit Yiew Diw Record Isol Help

= Pragrem Files ] D D D

B (5 Adobe | BsrEsT poc FILTER  LeadTook  PLUGIN
(=) Comman Files 1 "
e | B & )
8 ) EnoteAudd0iDlogo-

& e BGEPAJico  BGLTEdI BsaspidZsv  Bscdobdb  bedosl.bin

—&

—_——————————
Far Help, pres|F1 &3 (DI TEAC  CD-W54E

e |
Ref Name Description
© MenuBar Displays the various functions in menu format.
® Toolbar Displays the various functions as buttons.
©® Explorer Displays the Explorer tree and its contents.
Fields
@® Information Displays the information related to the disc.
Window
© Virtual Disc Displays the data for recording.
Fields ® When creating a data CD, drop the data into the data field
(the right column).

® When creating an audio/video CD or an image file, drop
the data into the track type field (the left column).
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Frequently Used Operations

This section describes two frequently used recording operations. For
more information, see the online help by pressing F1 or clicking Help >
Manual.

CAUTION:

To avoid recording failure, quit all other applications, including terminate-and-stay-
resident programs like clock and screen saver programs.

Any CD created from copyrighted material using the capturing or duplicating
functions will be controlled by copyright laws and should be for your own personal
use.

Copyinga CD

1. Launch B’s Recorder GOLD.

2. Select the Copy button on the Wizard.

3. Click Yes when the copyright prompt appears.

4. The CD Copy window appears. Insert the original disc in the combo
drive.

5. Click Start.

6. Unless you have special needs, use the default settings for the
Recording Speed, the Recording Type and whether you want to
record using On-the-Fly. Click Start when the settings are complete.

7. Once the original disc has been read, a prompt appears to change the
original disc for a black disc. Remove the original disc and insert a
blank CD-R in the drive.

8. When recording has been completed successfully, the disc is ejected
and a prompt appears. Click OK.

Creating a Data CD

1. Launch B’s Recorder GOLD.

2. Select the Data button on the Wizard.
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3. Drag the files to be recorded from the file browser in the upper part of
the window and drop them in the Data Edit field in the bottom part of
the windows.

4. Enter the volume label.
5. Click Record on the tool bar.

6. Unless you have special needs, use the default settings for the
Recording Speed, the Recording Type and whether you want to
record using On-the-Fly. Click Start when the settings are complete.

7. Insert a blank CD-R in the combo drive.
8. Click Start to start recording.

9. When recording has been completed successfully, the disc is ejected
and a prompt appears. Click OK.

Creating an Audio CD

NOTE: The audio CD created by this method may not play normally on a consumer CD
player.

1. Launch B’s Recorder GOLD.
2. Select the Audio button on the Wizard.

3. Drag the audio files (WAV, AIFF, MP3, TwinVQ, CDA) to be
recorded from the file browser in the upper part of the window and
drop them in the Track Edit field in the bottom part of the windows.

4. Click Record on the tool bar.

5. Unless you have special needs, use the default settings for the
Recording Speed, the Recording Type and whether you want to
record using On-the-Fly. Click Start when the settings are complete.

6. Insert a blank CD-R in the combo drive.
7. Click Start to start recording.

8. When recording has been completed successfully, the disc is ejected
and a prompt appears. Click OK.
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CHAPTER

Caring and Troubleshooting

The first part of this chapter gives you guidelines on taking care of your
system. Taking good care will ensure trouble-free operations and reduce
the risk of damage to your system.

The second part of this chapter tells you what actions to take when
encountering common problems.



Taking Care of the System

e Use the system where the temperature is between 10 °C (50 °F) and
35°C (95 °F).

e Avoid placing the system in a location subject to high humidity,
extreme temperatures, mechanical vibration, direct sunlight, or heavy
dust.

e Do not cover or block any ventilation openings on the system. For
example, do not place the system on a bed, sofa, rug, or other similar
surface. Otherwise, overheating may occur that results in damage to
the system.

e Keep the system at least 13 cm (5 inches) away from electrical
appliances that can generate a strong magnetic field such asa TV,
refrigerator, motor, or large audio speaker.

e Do not place the system on an unsteady surface.

e Gently wipe the display with a soft, lint-free cloth. Do not use alcohol
or detergent on the display.

e To maximize the life of the backlight in the display, allow the
backlight to automatically turn off as a result of power saving. Avoid
using a screen saver or other software that prevents power saving
from working.

e Never clean the system with its power on.

e The housing surface may be sensitive to chemical agents. To clean
the housing, use a soft cloth moistened with water or non-alkaline
detergent to wipe the exterior of the system.

7-2 Caring and Troubleshooting



Troubleshooting

CAUTION: After you have followed the instructions in this chapter and the problem still
persists, contact an authorized dealer for help.

Hardware, software, or both can cause your system to malfunction. When
you encounter a problem, it might be a typical problem that can be easily
solved.

Preliminary Checklist

Here are helpful hints to follow before you take further actions when you
encounter problems:

Try to isolate which part of the system is causing the problem.

Make sure that you turn on all peripheral devices before turning on
the system.

If an external device has a problem, make sure that the cable
connections are correct and secure.

Make sure that the configuration information is properly set in the
BIOS Setup program.

Make sure that all the device drivers are correctly installed.

Make notes of your observations. Are there any messages on the
screen? Do any indicators light? Do you hear any beeps? Detailed
descriptions are useful to the service personnel when you need to
consult one for assistance.
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CD/DVD Drive Problems

The CD/DVD drive cannot read a disc.

o The AutoPlay feature has been disabled at the factory. You can
manually run the program on the disc.

e Make sure that the disc is not damaged or defective.
e Make sure that the disc is correctly seated in the tray.

e Make sure that the disc is not dirty. Clean the disc with a CD cleaning
kit, available in most computer stores.

e Make sure that the system supports the disc types or files.

You cannot eject a disc.

e Manually release the disc following this method:
1. Turn off the system.
2. Insert a small rod, such as a straightened paperclip, into the
drive’s manual eject hole and push firmly to release the tray.
3. Pull the tray out until fully extended to remove the disc.

When you change the disc, the disc contents on the screen are not
automatically refreshed.

e This is because the AutoPlay feature has been disabled at the factory.
You can manually refresh the contents by exiting and restarting the
program.
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Display Problems

Nothing appears on the screen.

e During operation, the screen may automatically turn off as a result of
power saving. Press any key to see if the screen comes back.

e The brightness level might be too low. Increase the brightness using
Fn+F4.

The characters on the screen are dim.

e Increase the brightness of the screen using Fn+F4.

Bad dots appear on the display at all times.

e A small number of missing, discolored, or bright dots on the screen
are an intrinsic characteristic of TFT LCD technology. As long as the
total number of bad dots does not exceed 4, it is not regarded as a
LCD defect.

Resolution cannot be adjusted to the desired setting.

e Make sure that the VGA driver is installed correctly.

Entertainment Problems

The remote control does not work.

e Make sure that you use the remote control within the allowable
distance and angle.

e Make sure that the batteries are not weak.

e Make sure that the batteries are correctly installed.
Poor TV or FM broadcast signal.

e Use the fine tune feature.

e Relocate the antenna for the best possible FM signal reception.
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Floppy Disk Drive Problems

The Floppy Disk Drive does not work.

Make sure that the floppy disk drive cable is properly connected.

The Floppy Disk Drive In-use Indicator stays on.

Make sure that the floppy disk is not physically damaged.
Make sure that the floppy disk is inserted correctly.

The disk drive cannot write to a floppy disk.

Make sure that the floppy disk is formatted.

Make sure that the floppy disk is not write-protected.

Make sure that you are writing to the correct drive.

Make sure that there is enough space left on the floppy disk.
Make sure that the floppy disk is not physically damaged.

The disk drive cannot read a floppy disk.

Make sure that the floppy disk is formatted.

Make sure that you are reading the correct drive.

Hard Disk Drive Problems

The hard disk drive error message appears on the screen.

The hard disk drive has defects. Ask your dealer for help.

The hard disk drive operations seem slow.

The data files stored on the hard disk drive may be fragmented. Use a
tool such as Windows’ Disk Defragmenter to defragment the files.

The hard disk drive in-use indicator glows without blinking.

The data files stored on the hard disk drive may be fragmented. Use a
tool such as Windows’ Disk Defragmenter to defragment the files.
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Keyboard Problems

The keyboard does not respond.

e Try connecting an external keyboard. If it works, contact your
authorized dealer, as the internal keyboard cable might be loose.

The numeric keypad is disabled.

e Make sure that Num Lock is switched on. (Check if the Num Lock
Indicator on the keyboard panel lights green or not.)

LAN Problems

I cannot access the network.

e Make sure that the LAN cable is properly connected to the RJ-45
connector and the network hub.

e Make sure that the network configuration is appropriate.

e Make sure that the user name or password is correct.

Storage Card Problems

The storage card does not work.
e Make sure that the Card Reader driver is correctly installed.
e Make sure that the card is correctly seated.

e Make sure that the storage card is not physically damaged.

Modem Problems

The modem does not work.
e Make sure that the modem driver is correctly installed.
e Make sure that the telephone line is properly connected.

e Disable power saving settings.

Caring and Troubleshooting 7-7



Mouse Problems

The optical mouse is difficult to control.

e Make sure that you are not using the following surfaces for the
optical mouse: surfaces without texture (such as glass), reflective
surfaces (such as a mirror) and surfaces with irregular texture (such
as color pictures or magazines).

The USB mouse does not work.
e Make sure that the mouse driver is correctly installed.
e Make sure that the mouse cable is properly connected.

e Try connecting another mouse. If the other mouse works, your mouse
might be faulty.

PC Card Problems

The PC card does not work.
e Make sure that the card is correctly seated.

e Ifthe card requires an IRQ (interrupt), make sure that there is one
available.

The card stops communicating properly.

e The application may have been reset when the system was turned off
or in Standby mode. Exit and restart the application.

Power Options Problems (for Windows XP)

Windows XP does not enter Stand By mode automatically.

e Ifyou have a connection to another system, the computer does not
enter Stand By mode if the connection is actively in use.

e Make sure that the Stand By time-out is enabled.
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Hibernation does not work.

e Make sure that you have enabled Hibernation in Windows XP.

The system does not enter Standby or Hibernation mode
immediately.

e If the system is performing an operation, it normally waits for the
operation to finish.

Software Problems

An application program does not work correctly.
e Make sure that the software is correctly installed.

e [ferror messages appear on the screen, consult the software
program’s documentation for further information.

e Ifyou are sure the operation has stopped, restart the system.

Sound Problems

“MESB.EXE. error” message appears on the screen. There is no
sound even if you restart the system.

e  When such error occurs, the sound is automatically muted. Uncheck
the Mute box from Control Panel > Sounds and Audio Devices >
Volume tab.

No sound is produced.

e Make sure that the volume is not muted or set too low. The mute and
volume status may remain when you switch from a home
entertainment element to another.

e Make sure that the Control Panel > Sounds and Audio Devices >
Volume tab > Advanced button in Device volume settings are
correct according your source of sound.

e Make sure that the audio driver is correctly installed.
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e [fusing an external audio device, make sure that the cable is properly
connected.

When adjusting the volume through Windows tool bar or a
program, the result is not as expected.

e Make sure that the Control Panel > Sounds and Audio Devices >
Volume tab > Advanced button in Device volume settings are
appropriate according your source of sound.

Distorted sound is produced.

e Make sure that the volume is not set too high or too low. In most
cases, high settings can cause the audio electronics to distort the
sound.

The sound does not record.

e Adjust the playback or recording sound levels.

The external microphone or audio device does not work.
o Make sure that the cable is properly connected.
e Make sure that the audio driver is correctly installed.

e  Check the volume control of your system.

Startup Problems
When you turn on the system, it does not respond and the Power
Indicator does not light green.

o Make sure that the AC power cord is correctly and securely
connected. The Power Indicator should light red when AC power is
connected.

When you start the computer, it stops after POST.

e Restart your computer.
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The message “Operating system not found” appears on the screen
after you turn on the system.

Make sure that there is no floppy disk in the floppy disk drive. If there
is, remove it and restart the system.

If this message appears when you are booting from the hard disk,
insert a bootable disk in the floppy disk drive and check the condition
of the hard disk.

The message “Invalid system disk” or “Disk error” appears on the
screen after you turn on the system.

If you are deliberately trying to boot from a floppy disk, replace the
disk with a bootable one and press any key to continue booting.

If you are booting from the hard disk; make sure that there is no
floppy disk in the floppy disk drive. If there is, remove it and restart
the system.

If this message appears when you are booting from the hard disk,
insert a bootable disk in the floppy disk drive and check the condition
of the hard disk.

Other Problems

The date/time is incorrect.

Correct the date and time via the operating system or BIOS Setup
program.

After you have done as described above, if you still have the incorrect
date and time every time you turn on the system, the RTC (Real-Time
Clock) battery is at the end of its life. Call an authorized dealer to
replace the RTC battery.
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Appendix

This appendix gives reference information including:
e Specifications

e BIOS Setup



Specifications

| NOTE: Specifications are subject to change without notice.

Parts Specifications

CPU

Intel Desktop Celeron (Willamette), 1.7~2.0 GHz or
above;

Intel Desktop Celeron (Northwood), 2.0 GHz or above;
Intel Desktop P4 (Northwood), 2.0~3.06 GHz or above
Front Side Bus 400/533 MHz; DDR200/266

Hyper Threading support (3.06 GHz or above)

Cache Memory

512-KB on-die (Pentium 4)/128-KB on-die (Celeron)

ROM BIOS

512-KB Flash EPROM (system and VGA BIOS);
ACPI1.0b

RAM

System

Two 184-pin DDR-200/266/333 SO-DIMM sockets for a
maximum of 1.0 GB memory, PC2100/PC1600 with
SPD support

Shared Video

8/16/32 MB (default 32MB)

Display

Panel

17-inch TFT XGA LCD, resolution up to 1024x768,
24-bit color by dithering, covered with reinforced glass

Video
controller

AGP 4X interface, MPEG-2 support, 8.5 MB/s capability

TV card *

FM input connector, TV RF F-type connector, video
input connector with adapter for one S-video connector
and one composite video connector

Keyboard

Standard keys, numeric keypad, 12 function keys, a
special Fn (Function) key and Windows keys

Mouse *

USB mouse with scroll function; optical-type

Storage
device

Floppy disk
drive *

USB 3.5-inch, 1.44-MB

Hard disk drive

3.5-inch, IDE, Ultra-DMA 66/100/133 support

CD/DVD drive

Slim-type, 12.7 mm height,
CD-ROM, CD-RW, DVD or Combo

A-2

Appendix



Audio | Audio AC97 v2.1 codec, power amplifier, 3D output
controller
Audio port Four audio ports for Mic-in / Line-out / Line-in / optical
interface S/PDIF
/O ports Four USB v.2.0 ports, standard and mini-IEEE 1394a
ports, IR port for remote control, system power
on/off/standby support
PC Card slot Type-I1, CardBus support
Card Reader * 4-in-1 (SM/MMC/SD/MS card) module
Modem MDC 56-Kbps internal fax modem v.92
LAN Fast Ethernet, 10/100Base-T
Power Power Supply 180 W
Dimension (WxHxD) 19.02x14.23%3.48 inch (483x361.5x88.5 mm) without
keyboard and power supply
Weight Less than 23.1 1b (10.5 kg)

Environment Temperature

Operating: 10 °C (50 °F) to 35 °C (95 °F)
Storage: 0 °C (32 °F) to 60 °C (140 °F)

Environment Humidity

Operating: 20% to 80% non-condensing
Storage: 10% to 90% non-condensing

Table Note:
* Select models only.
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BIOS Setup

BIOS Setup (SCU or Setup Configuration Utility) is a program for
configuring the BIOS (Basic Input/Output System) settings of the system.
BIOS is a layer of software, called firmware, that translates instructions
from other layers of software into instructions that the system hardware
can understand.

Starting BIOS Setup

NOTE:

e The Setup screens shown in this manual are for your reference only. The actual
items or settings on your system may differ.

o The Setup program may have been updated after the publication of this manual.

You need to run the BIOS Setup program when:
e You see an error message on the screen requesting you to run Setup.

e You want to set a password, change the boot sequence or enable the
hard disk boot sector protection.

To run BIOS Setup, press F2 when the prompt appears in the lower left
corner of the screen during system startup. The prompt shows up on the
screen for only a few seconds. You must press F2 quickly. The BIOS
Setup menu appears.

To move around and make selections, use the keyboard. Keyboard
information can be found at the bottom of the BIOS Setup screen.
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Main Menu

HT Support 14

Date and Time sets the system date (Year, Month, Day) and time (Hour,
Minute, Second).

HT Support enables the CPU to utilize its execution resources more
efficiently as two virtual CPUs to increase performance and improve user
productivity. Enable this item for Windows XP or OS optimized for the
Hyper Threading (HT) technology; otherwise, disable this item. Use the
Disable/Enable sub-item in the sub-menu to change the setting.

| NOTE: This item is available only when the CPU supports the HT feature.

Security Menu

Set Password >

_Hard Disk Boot Sector

Set Password allows you to set the password for your system. When
typing the password, first make sure that Num Lock is off, and then type the
password in the entry fields and press Enter. Confirm your password by
typing it again and pressing Enter. If the Enable Password to Power-on
sub-item is enabled, the set password is always required to boot the
system.

Hard Disk Boot Sector sets if a warning message will appear when the
hard disk boot sector (partition table) has been changed. A checkmark
(v) indicates Enabled while an underline () indicates Disabled. The
default setting is Disabled.

CAUTION: Set this item to Disabled before installing an operating system, running
Fdisk or Format program. Otherwise, the intended action will fail.
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Boot Menu

Boot Sequence )

Boot Sequence sets the first, second, third, and fourth boot device. The
system will try to boot from the first device but if it is not available, will
try the next boot device. If you set the first boot device to LAN Boot, the
system will boot from the LAN server first. The default setting is Floppy
Disk Drive, Hard Disk Drive, CD-ROM Drive, and LAN Boot.

NOTE: If you set all booting options to the same device, then the system will try to boot
from that device only.

Exit Menu

Save Changes and Exit »

Discard Changes and Exit »

Get Default Values >
Load Previous Values >

Save Changes and Exit saves changes you have made and exits the
BIOS Setup program.

Discard Changes and Exit exits the Setup program without saving the
changes you have made.

Get Default Values loads factory default values for all the items.

Load Previous Values restores previous values for all the items.
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Index

A

AC power cord
Connecting, 1-12
Alt key, 2-4
Application key, 2-5
Audio CD
Playing in AV mode, 3-2
Playing in PC mode, 4-2
Audio features, 2-17, 3
Connecting external audio devices, 5-4
Installing the audio driver, 6-5
Troubleshooting, 7-9
Audio input connector, 1-7, 5-4
Audio output connector, 1-7, 5-4
AV mode, 1-13, 3-1
CD player, 3-2
DVD player, 3-4
FM radio, 3-8
MP3 player, 3-2
Powering off, 1-14
Powering on, 1-13
TV, 3-6
AV video device, 5-6
AV/S video cable, 5-6

B

B’s Recorder GOLD, 6-6
Copying a CD/DVD, 6-10

Creating a data CD, 6-10

Installing, 6-6

Launching and quitting, 6-8
Backspace key, 2-4
Battery

Remote control, 1-11
BIOS Setup, 4

Exit menu, 6

Main menu, 5

Security menu, 5
Bookmark, WinDVD, 4-5
Boot sector, 5
Booting, 2-2

Boot device, 6
Brightness control, 1-4, 1-15

C

Cable TV

Connecting, 1-11

Watching TV in AV mode, 3-6

Watching TV in PC mode, 4-13
Caps Lock, 2-5

Indicator, 1-4
Caption

DVD in AV mode, 3-5

DVD in PC mode, 4-9

TV in AV mode, 3-7, 4-17
Capture

WinDVD, 4-5

WinFast TV, 4-16



Card Reader, 1-6, 5-10, 3
Inserting a card, 5-11
Installing the Card Reader driver, 6-5

CardBus, 5-8

CD. See CD/DVD drive

CD player
AV mode, 3-2
Using the remote control, 3-3

CD/DVD drive, 1-5, 2-14, 2
Inserting a CD, 2-15
In-use indicator, 1-4
Manually ejecting a CD, 7-4
Troubleshooting, 7-4

CD-R, 2-14

CD-ROM drive. See CD/DVD drive

CD-RW, 2-14

Click, 2-9

Combo drive. See CD/DVD drive

Connecting external devices
Audio device, 5-4
IEEE 1394 device, 5-3
Microphone, 5-4
USB device, 5-2
Video device, 5-6

CPU, 2
Ctrl key, 2-4
Cursor, 2-5

Cursor-control key, 2-5

D

Date, 7-11, 5
Dimension, 3
Double-click, 2-9
Drag and drop, 2-9
Drive A, 2-10
Drive C, 2-13
Drive D, 2-14
Drive E, 5-11
Driver installation, 6-4
DVD, 2-14

Playing in PC mode, 4-2
DVD player

AV mode, 3-4

PC mode, 4-2
DVD-ROM drive. See CD/DVD drive

E

EEPROM, 2
Esc key, 2-4
Euro sign, 2-7

F

Favorite channels
FM radio (AV mode), 3-9
WinFast FM, 4-28
WinFast TV, 4-18
Ferrite core
Attaching to the modem cable, 2-19
Firmware, 4
Floppy disk drive, 2-10, 2
Connecting, 2-10
Ejecting floppy disks, 2-11
Inserting floppy disks, 2-11
Troubleshooting, 7-6
FM antenna
Connecting, 1-11
Connector, 1-5
FM radio
AV mode, 3-8
Favorite channels in AV mode, 3-9
Favorite channels in PC mode, 4-28
PC mode, 4-25
Recording in PC mode, 4-30
Troubleshooting, 7-5
Using the remote control, 3-8
Function key, 2-7

H

Hard disk drive, 2-13, 2
Boot sector, 5
In-use indicator, 1-4
Troubleshooting, 7-6
Hibernation, 2-3
Troubleshooting, 7-9
Hot keys, 2-7
Humidity, 3
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/O ports, 3
IEEE 1394 port, 1-7

Connecting an IEEE 1394 device, 5-3
Indicator

Caps Lock, 1-4

CD/DVD drive, 1-4

Floppy disk drive, 2-12

Hard disk drive, 1-4

Num Lock, 1-4

Power, 1-4

Scroll Lock, 1-4

Standby mode, Windows XP, 1-4
Instant Play, 6-3

K

Keyboard, 1-8, 2
Folding, 1-15
Troubleshooting, 7-7
Using the keyboard, 2-4

L

LAN, 2-19, 3
Connector, 1-8
Installing the LAN driver, 6-5
Troubleshooting, 7-7

LCD, 1-4,2-17,2
Adjusting the angle, 1-14
Adjusting the brightness, 1-15
Troubleshooting, 7-5

M

Memory
Cache, 2
System, 2
Memory card. See Storage card
Memory Stick. See Storage card
MESB. See Multimedia Easy Start button
Microphone connector, 1-7, 5-4
Modem, 3
Connecting the modem cable, 2-18

Installing the modem driver, 6-5
Troubleshooting, 7-7
Modem cable
Connecting, 2-18
Mouse, 2-8, 2
Configuring, 2-9
Troubleshooting, 7-8
MP3
Playing in AV mode, 3-2
Playing in PC mode, 4-11, 4-30
MP3 player
AV mode, 3-2
Using the remote control, 3-3
Multimedia Easy Start button, 1-8, 1-13
Installing the MESB driver, 6-5
MultiMediaCard. See Storage card

N

Network. See LAN

Num Lock, 2-5
Indicator, 1-4

Numeric key, 2-6

O

Operating system, 2-2
Optical mouse, 2-8

P

Partition table, 5

Password, 5

Pause key, 2-5

PC Card, 5-8, 3
Inserting, 5-8
Removing, 5-9
Slot, 1-6
Troubleshooting, 7-8

PC mode, 1-13, 4-1
DVD player, 4-2
FM radio, 4-25
Powering off, 1-14
Powering on, 1-13
TV, 4-13

PCMCIA, 5-8
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PIP
PC mode, 4-20
Playing recorded radio, 4-30
Playing recorded TV, 4-21
Playlist
WinDVD, 4-11
Point, 2-9
Pointing device, 2
Power, 3
Connecting, 1-12
Powering off, 1-14
Powering on, 1-13
Power button, 1-4, 1-13, 2-2
Power connector, 1-6
Power Options, Windows XP, 2-2
Troubleshooting, 7-8
Print Screen key, 2-5

R

RAM, 2

Real-Time Clock (RTC), 7-11

Recording
Live radio in PC mode, 4-30
Live TV in PC mode, 4-21

Region, WinDVD, 4-9

Remote control
Installing the battery, 1-11
Installing the MESB driver, 6-5
Listening to FM radio, 3-8
Playing audio CD, 3-3
Playing MP3 files, 3-3
Troubleshooting, 7-5
Watching TV, 3-6

Remote sensor, 1-4

RJ-11 connector, 1-7, 2-18

RJ-45 connector, 1-8, 2-19

ROM BIOS, 2

S

S/PDIF, 5-5
Connector, 1-7
Scheduling events

Scroll Lock, 2-5
Indicator, 1-4
SCU, 4
Secure Digital. See Storage card
Shift key, 2-4
Shutting down Windows XP, 2-2
Site selection, 1-9
SmartMedia. See Storage card
Soft-off, 1-4
Software, 6-2
Troubleshooting, 7-9
Speaker, 1-4
Connecting a digital speaker set, 5-5
Connecting external speakers, 5-4
Specifications, 2
Stand By, Windows XP, 2-2
Indicator, 1-4
Troubleshooting, 7-8
Starting up Windows XP, 2-2
Startup
Troubleshooting, 7-10
Storage card, 1-6, 5-10
Inserting, 5-11
Removing, 5-11
Troubleshooting, 7-7
Subtitle, DVD
AV mode, 3-5
WinDVD, 4-7
S-video device, 5-7

T

Telephone line
Connecting, 2-18
Connector, 1-7
Temperature, 3
TFT, 2-17
Time, 7-11, 5
Time shifting
PC mode, 4-19
Time-stretching, WinDVD, 4-6
Troubleshooting
CD/DVD drive problem, 7-4
Checklist, 7-3
Display problem, 7-5

Radio, 4-31 Floppy disk drive problem, 7-6
TV events, 4-22 FM radio, 7-5
Scroll, 2-9 Hard disk drive problem, 7-6
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Keyboard problem, 7-7
LAN problem, 7-7
Modem problem, 7-7
Mouse problem, 7-8
Other problem, 7-11
PC Card problem, 7-8
Power options problem, 7-8
Remote control, 7-5
Software problem, 7-9
Sound problem, 7-9
Startup problem, 7-10
Storage card problem, 7-7
TV, 7-5
TV
AV mode, 3-6
Favorite channels, 4-18
Recording in PC mode, 4-21
Scheduing events, 4-22
Time shifting in PC mode, 4-19
Troubleshooting, 7-5
Using the remote control, 3-6
Watching in PC mode, 4-13
TV card, 1-11, 2-17,2
Installing the TV card driver, 6-5
TV RF F-type connector, 1-5
Typewriter key, 2-4

U

USB port, 1-6, 1-8, 5-2
Connecting a USB device, 5-2

V

VCD, 2-14
Playing in PC mode, 4-2

Video features, 2-17
Connecting external video devices, 5-6
Controller, 2

Installing the video driver, 6-4
Video memory, 2
Video Input connector, 1-5
Viewing angle, DVD
AV mode, 3-5
WinDVD, 4-7
Volume control, 2-7, 2-17

W

Weight, 3
Wide screen, WinDVD, 4-7
Windows Logo key, 2-5
WinDVD, 4-2
Bookmark, 4-5
Capture, 4-5
Conrol Panel, 4-3
Installing the program, 6-5
Playing files, 4-10
Remote control, 4-3
Subpanel, 4-7
Zoom, 4-5
WinFast FM, 4-25
Configuration, 4-32
Control Panel, 4-26
Managing channels, 4-28
Remote control, 4-26
Scanning channels, 4-25
WinFast TV, 4-13
Configuration, 4-23
Control Panel, 4-15
Managing channels, 4-17
Remote control, 4-15
Scanning channels, 4-14

Z

Zoom, WinDVD, 4-5
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